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1 Preface

1.1 About the program

The Mag2Pol source code is entirely written in C++ and can be downloaded in compiled

form for the main platforms Windows, MacOS and Linux. The program is based on the

Qt5, QCustomPlot, Eigen and OpenGL libraries.

1.2 Purpose of the program

Mag2Pol was developed to supply an easy-to-use tool for analyzing spherical neutron

polarimetry data obtained from single-crystal neutron scattering experiments using the

Cryogenic Polarization Analysis Device (CRYOPAD). In addition it can treat flipping ra-

tios in combination with a multipole expansion of the magnetic form factor. The analysis

of nuclear and magnetic structures based on integrated intensites is of course also possible.

Since version 2.4 multiple-wavelength integrated intensity data as well as X-ray data can

be treated. Version 2.4.1 introduces the calculation of Schwinger scattering flipping ratios.

Rietveld refinement of powder data was introduced in version 4.0.

Crystal and magnetic structure models can easily be introduced via the graphical user

interface (the latter also with the help of the Irreducible Representation tool) and viewed

in 3D in an OpenGL widget. Those models can then be refined to experimental data

within a least-squares refinement. Hereby, spherical neutron polarimetry data, integrated

intensities from a standard single-crystal diffraction experiment and powder/x-ray diffrac-

tion data can be simultaneously analyzed in any combination.

1.3 Disclaimer

Mag2Pol is distributed under the GNU Lesser General Public License v. 3 (LGPLv3).

The complete Qt5 source code of the used Qt5 libraries can be downloaded from the

Mag2Pol download page (note that the original code was not modified). The program

is distributed with dynamically linked libraries which can be rebuilt by the user, if they

1



1 Preface

wish to use a different Qt version. A copy of the LGPL license text can be viewed in the

About window accessible from the main menu.

2



2 Getting started

2.1 Installation

2.1.1 Windows

In order to run under Windows Qt5 depends on Microsoft Visual Studio. The Visual

Studio Redistributable Packages are included in the download of Mag2Pol and have to

be installed by running vcredist x64.exe. Afterwards, Mag2Pol can be started from

its executable, which should stay in its folder with all necessary libraries.

2.1.2 MacOS

Open the downloaded dmg image and drag the application to your Applications folder or

directly download Mag2Pol from the Mac App Store. Once the prompt appears saying

that the application cannot be opened (after the first attempt of starting the application

downloaded from the Mag2Pol website), cancel it and launch System Preferences. Nav-

igate to the Security & Privacy section, and under the General tab you’ll see the blocked

program. Simply click Open Anyway to launch it.

2.1.3 Linux

• AppImage (only 64 bit Linux versions)

Download and launch the AppImage.

• Debian package (only up to Mag2Pol version 3.0)

Download gdebi from a terminal by typing sudo apt-get install gdebi. Then

install the debian package with sudo gdebi mag2pol 3.0.0-1 amd64.deb, which

will download the necessary libraries from the internet. Start the program by typing

Mag2Pol.

2.2 Setting up a structure model

The main window contains a toolbar for the most frequently used menu entries and dock-

able widgets, which can be reorganized to one’s individual taste. Moving a widget on top

3



2 Getting started

of another will automatically create a tab widget and single tabs can be extracted to form

new widgets. All the settings related to the toolbar and the dock widgets can be found in

the View menu. Six different presets of different window dispositions can be accessed with

the shortcuts Ctrl/Cmd + 1-6. Note that the exact position and size of the individual

widgets are saved, when the program is closed and restored at the next start.

The first step for a meaningful use of Mag2Pol is the parametrization of a nuclear and

eventually magnetic structure model in the main window. This is done in the tab widget

on the upper left part of the main window, when Mag2Pol starts up (shown in red in

Fig. 2.1) or by loading a *.cif or *.mcif file.

The crystallographic space group (CSG) of the underlying nuclear structure has to be

entered in Hermann-Mauguin notation in the corresponding field under the Symmetry

tab. It is also possible to enter a magnetic space group (MSG) or a magnetic superspace

group (MSSG), see also Sec. 6.2 for more information about space groups. Note that all

information related to MSGs and MSSGs is based on the tables available at the Isotropy

Software Suite [1], and in particular ISO-MAG [2] and ISO(3+d)D [3–6]. The entry

of a CSG, MSG or MSSG is case dependent, i.e. the first letter should be upper case

and any following letters lower case. Eventual additional spaces will be removed. Note

that for MSGs and MSSGs lower-case symbols need to be preceded by an underscore (e.g.

P2 1’ in order to distinguish P2′1 from P21′) in order to avoid ambiguity, while this is

not necessary for CSG. For MSGs having the same label as a CSG an underscore should

be added (e.g. Pmna for the MSG and Pmna for the CSG). The symbol will be shown

in green, if the space group has been recognized, and in red in the contrary case. In the

case of CSGs, all alternative monoclinic settings are included as well as space groups with

different origin choices or trigonal space groups with different axes settings (hexagonal or

rhombohedral). For MSGs and MSSGs the following conventions are chosen by default:

monoclinic unique axis b, monoclinic cell choice 1, hexagonal axes for trigonal groups and

origin choice 2 for groups with more than one origin choice. Alternatively, the space group

can be entered by its number or its numerical label in case of a MSG or MSSG. If the

entry is followed by # the numerical entry will be replaced by the space group label (e.g.

139# for space group I4/mmm). If an entered CSG has origin or axes setting choices a

combo box will appear next to the space group field, in which the corresponding choice

can be entered. For cell transformations the Space group tables tool has to be used (see

Sec. 6.2).

The lattice parameters should be given in Ångströms and degrees. If a CSG was entered

the magnetic symmetry should be given by a number of symmetry operators (generators)

which can be constructed from the drop-down menues. The first part featuring xyz refers

to the symmetry operator which is applied to the atomic position, whereas the second part

featuring uvw is the corresponding symmetry operation acting on the magnetic moment.

4



2.2 Setting up a structure model

Figure 2.1: Mag2Pol main window at the program start (in the Compact 1 preset).

The cyan box shows the toolbar from which most of the menu entries can be triggered.

The crystal and magnetic structure information are entered in the tab widget marked by

the red box. The green box contains the OpenGL widget for the 3D visualization of the

nuclear and magnetic structure and the drawing box given in relative lattice coordinates.

The blue box is devoted to the experimental geometry including wavelength and sample

orientation. Individual calculations for a given (hkl) reflection can be triggered from

here. The calculated angles corresponding to the instrument geometry are shown in the

respective boxes. The results of the calculations (nuclear/magnetic structure factors,

flipping ratios, etc.) are shown in the orange output box.

5



2 Getting started

Each symmetry operator can be combined with a magnetic phase. Note that the magnetic

symmetry can be obtained from calculating the irreducible representations through the

menu item Generate→Irreducible representations (see Sec. 6.4). In that case it is not nec-

essary to enter the magnetic symmetry operators by hand. The use of a MSG or MSSG

will automatically set the magnetic symmetry. Mag2Pol supports the loading of *.mcif

files for MSGs and MSSGs together with the appropriate transformations.

Under the tab Atomic positions the different sites can be entered by adjusting the corre-

sponding number. Each site needs an atom label which corresponds to the element symbol

in case of a purely nuclear scatterer. For a magnetic atom, the label starts with an M or

J followed by the element symbol and the oxidation state, e.g. MCo3 or JHo3. The M

refers to the magnetic form factor containing only spherical Bessel functions ⟨j0⟩, while
J denotes a magnetic form factor of rare-earth elements approximating ⟨j0⟩+ c2⟨j2⟩. For
the calculation of Schwinger flipping ratios the exact x-ray form factor is needed for which

the oxidation state should be given as e.g. Co2 for a non-magnetic atom. Contrarily to

the space group symbol, the entry is case independent, however, no spaces can be used.

An isotropic temperature factor B and an occupation factor (1 for a fully occupied site)

can be entered for each site. Anisotropic temperature factors can be chosen by right-

clicking the isotropic value, which opens a pop-up menu for activating and setting the

values. Depending on the site symmetry certain entries of the anisotropic temperature

tensor may be 0 or constrained. In Mag2Pol this is handled automatically by determin-

ing the site-symmetry group. As stated in [7] one should choose the first atomic position of

an equivalent set given in the International Tables Vol. A [8] in order to obtain the correct

restrictions. When the tensor is the zero matrix it will be initialized as isotropic according

to the isotropic temperature factor following [9]. The inverse operation is also possible: the

isotropic temperature factor can be set as an equivalent one from the anisotropic tensor

by evoking the previously mentioned pop-up menu. Anisotropic displacement ellipsoids

can be visualized in the unit cell by checking the corresponding checkbox in the settings

menu (see this demo video).

If a magnetic ion has been recognized, it will be displayed in the Magnetic structure

tab, where its complex Fourier components and a phase factor can be entered (in the case

of user-defined basis vectors or basis vectors of irreducible representations, the coefficients

of those basis vectors should be entered here, see Sec. 3.5 and Sec. 6.4). In addition, the

propagation vector can be entered here, which relates the translational symmetry of the

magnetic cell to the nuclear one. The checkbox +q ̸= −q is automatically set when the

propagation vector or the space group is changed. It should be activated, when q− (−q)

6
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2.3 Visualizing crystal and magnetic structures

does not correspond to a vector of the reciprocal lattice. The automatic setting can always

be overridden, e.g. if the reflections were measured with a component 0.501 which in fact

should be commensurate.

A generated structure can be converted to space group P1 by right-clicking the label

Space group and selecting convert to P1. This will add all atoms (formerly generated by

the space group symmetry) to the list in the Atoms tab, which can be useful if one wants

to treat the nuclear/magnetic structure without symmetry constraints. If a structure is

already expressed in P1 symmetry, an additional menu entry create supercell is visible in

the context menu. When clicked, the supercell can be given in the form of na x nb x nc

(note that the x are optional, spaces work as well), which will then be applied to the lattice

parameters and to all atomic positions.

It is possible to set up multiple phases. When treating single-crystal data, this feature can

be useful in the presence of co-existing magnetic structures which have the same propa-

gation vector and therefore contribute to the same magnetic reflections. Multiple phases

may also be used to generate or analyze a powder pattern.

In order to create an additional phase simply right-click the Phase label above theOpenGL

widget and under theAdd phase menu choose eitherNew phase or Duplicate current phase.

In the latter case a copy of the present phase will be generated which can then be modified.

The different crystal and magnetic structures can be visualized by modifying the phase

number through the arrow buttons. A volume fraction is associated to each phase which

can be set in Structure→Phases, domains and twins.

Different example videos are available for setting up a structure model, setting up a simple

magnetic structure or setting up a complex magnetic structure.

2.3 Visualizing crystal and magnetic structures

Once all necessary parameters have been entered, the crystal and magnetic structures

can be visualized by triggering the menu entry Generate→Unit cell or using its shortcut

(Ctrl/Cmd+U). In case of a missing or erroneous input, the corresponding error message

should pop up. Mag2Pol can optionally check, if the atomic positions entered by the user

are not too close to a special position of the space group. This would lead to generated

atoms which are too close to each other and trigger a warning. This option and also the

shortest allowed distance between generated atoms can be set in Settings→Symmetry.

The perspective can be modified by dragging within the OpenGL widget. A rotation

around the axis vertical to the viewing plane can be achieved by dragging within the

upper or lower left corner of the widget. Zooming in and out is done via the mouse

wheel, wheras the original zoom can be restored with a right click. The view can be

7
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2 Getting started

shifted by keeping the Ctrl/Cmd key pressed while dragging. The bounding box of the

volume to plot can be modified in the spin boxes corresponding to relative units of the

lattice constants. If more than one phase or magnetic domain is present, each individual

structure can be viewed by selecting the respective phase/domain number in the spin box.

The position of the light source can be modified by dragging the scene while pressing the

Alt key. The default position is restored by Alt+rightclick.

The appearance of every atom/spin site can be modified with the plot options shown at

the right of the atomic position. A site can be turned invisible by removing the tick below

plot. A right-click on either of the plot check boxes opens a context menu from which it

can be chosen wheter all, only nuclear or only magnetic atoms will be plotted. The color

can be chosen by clicking on the colored square and then by setting the RGB values in

the pop-up window. The color boxes also provide convenient shortcuts through a context

menu: a selected color can be applied to all atoms, all nuclear atoms, all magnetic atoms

or all atoms with the same label. The sizes of the atoms and spins can be defined in

the boxes size a and size s, respectively. If the Fourier components are imaginary and

the imaginary part is perpendicular to the real part (within 1◦) then an envelope will be

drawn automatically emphasizing the rotation plane of the spin.

The objects to be plotted can be chosen from the Settings menu together with the quality

and resolution of the objects. The coordinate axes can be plotted in the lower-left corner

instead of the colored unit cell axes. Also, a smart legend can be added in the upper-left

corner, which will automatically adjust the legend entries depending on repeated elements

with the same appearance (such sites will automatically be numbered, e.g O1, O2, O3...).

Furthermore, multiple unit cell edges can optionally be plotted as well as multicolored

atoms representing the respective occupation of shared sites. Furthermore, Mag2Pol

features antialiasing by using multisampling per pixel and the objects’ distance to the

viewer is calculated for each view which allows for a correct back-to-front rendering of

transparent objects. Those features massively increase the quality of the rendered picture.

TheOpenGL objects have been designed in order to minimize the calls to the frame buffer,

for which the improved graphics don’t come alongside with slower performance.

2.4 Distances and angles

Once a (magnetic) structure is drawn in the OpenGL widget the user can visualize atomic

positions, magnetic moment values, bond distances, angles between 3 atoms and angles

between two spins. In order to get information concerning the position of an atom or the

Fourier components of a magnetic moment, just click on the atom (sphere) or on the cone

of the spin, respectively. The information will be shown in the status bar of the main

window and the object will be drawn with a different texture. In order to get distances

8



2.5 Bonds and polyhedra

between 2 atoms click the first atom and then Shift-click a second one, which will show

the distance in the status bar and will draw the bond between those 2 atoms. The same

procedure has to be done to get the angle between 2 spins. For the angle made up by

3 atoms simply Shift-click the 3 atoms. Note that you can rotate the perspective in

between Shift-clicks if necessary.

Figure 2.2: Geometry options in Mag2Pol.

2.5 Bonds and polyhedra

Mag2Pol features the plotting of bonds and polyhedra. After a structure has been

generated this can be done via the Generate→Bonds menu or the toolbar icon. A control

window will open up, which is shown in the upper part of Fig. 3.1. Here the number of

bond types to search and generate can be entered which creates the according number of

rows in the Bonds and Polyhedra tables. The center (atom1) and ligand (atom2) atoms

can be chosen from the combo boxes. Note that the content of these boxes is a list of

elements followed by the list of sites. In the example shown in Fig. 3.1, the structure

contains two Co sites, so in order to plot all possible Co-O bonds, irrespective of the

specific site, the elements have been chosen from the first (element) list. A number of

parameters can be adjusted in order to control the bond distances and the appearance

of the rendered objects. The meaning of these parameters are explained when hovering

9



2 Getting started

the mouse over the horizontal header items. Note that the minimal distance between the

center atom and the polyhedron faces should be increased, if the resulting polyhedra look

unexpected. This can be the case for heavily distorted polyhedra. The information about

bonds created in the OpenGL widget can be retrieved by clicking on the center of the

bond. This will show the two connected atoms, their positions and the bond length in the

status bar of the window.

The parameters for the bond search as well as for the appearances of bonds and polyhedra

are saved in the *.xml file.

Figure 2.3: Bonds and polyhedra plotting in Mag2Pol.

10
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2.6 Saving and loading input files

All parameters which have been entered or modified can be saved into an input control

file in xml format from the menu entry File→Save/Save as. Additional information con-

cerning scale and extinction factors, magnetic domains, fit parameters and constraints,

user-defined magnetic form factors, powder patterns, plot parameters like the cell range,

the perspective and the zoom are saved as well. Note that if a magnetic (super) space

group is used after having calculated irreducible representations, the latter will not be

saved in the xml file. The respective parameters will be explained in Sec. 3. Saved input

files can be loaded via File→Load. The Mag2Pol main window can also be reset by

File→Reset.

Crystal and magnetic structures can also be exported in *.cif or *.mcif format. When

the propagation vector is 0, the magnetic symmetry will be exported either using the

user-defined magnetic symmetry operators or that given by an irreducible representation.

Note that only 1-dimensional irreps can be exported and that for mixed representations

only the first will be considered. For non-zero propagation vectors the magnetic moments

(real vectors) will be calculated for all atomic sites and the structure will be exported in

P1 symmetry.

2.7 Calculation of structure factors and polarization matrices

Besides the correct description of a magnetic structure, Mag2Pol needs information

concerning the experimental geometry in order to calculate the nuclear/magnetic struc-

ture factors and the polarization matrices. Herefore, the wavelength should be given in

Ångströms, which already allows the calculation of structure factors. The calculation of

the polarization matrix depends on the orientation of the sample, which can be given

either by defining the vertical sample axis (reciprocal lattice vector) or by supplying the

orientation matrix of the experiment in the menu Geometry→Orientation matrix. In the

latter case the instrument angles are automatically calculated and shown in the respective

boxes. For the 4-circle geometry a ψ value can be given, which is the rotation angle around

the scattering vector, where ψ = 0 refers to bisecting geometry. From any given angles

the corresponding (hkl) indices can be calculated by right-clicking any angle value and

selecting calculate hkl.

Note that that the flipping ratio geometry requires the use of the vertical axis (not Cry-

ocradle). The vertical axis will automatically be calculated and set after setting the

normal-beam orientation matrix. Since in a flipping ratio experiment one usually assumes

the magnetic moments to be aligned parallel to the vertical direction (magnetic field di-
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2 Getting started

rection) one can align the moments automatically by right-clicking the label z axis and

choosing set moments parallel. If the UB matrix is not given the program will calculate

the moment direction from the values given for the vertical axis. Note that the uvw com-

ponents of the magnetic moments will have to be constrained in a refinement. Another

option is to use user-defined basis vectors before aligning the moments vertically, which

requires the refinement of only one parameter.

With Mag2Pol it is possible to calculate flipping ratios due to Schwinger scattering [10–

13], which is automatically done in the absence of magnetic ions in the unit cell (e.g. use

Fe2 instead of MFe2). Note that the polarization axis of the neutrons is taken to be parallel

to ki × kf .

The calculations are done for the Bragg reflection (hkl)±q entered by the user by pressing

Go! (see also this demo video). If the propagation vector is 0, there is no difference

concerning the combo box. When more than one propagation vector was entered in the

Domain window (see Sec. 3.3), they will all be shown in this combo box and by selecting

e.g. (hkl)-q2 the program will automatically check if a contribution from another config-

uration domain is present at the Q position.

If the checkbox show is activated, the local coordination system (see Sec. 7) and the mag-

netic interaction vector M⊥ are drawn.

The results of the calculation are shown in the output text window (orange box in Fig. 2.1)

and the individual polarization matrix entries are shown in their respective boxes in the

Geometry section of the window (blue box in Fig. 2.1).

Whole lists of reflections can be generated under Generate→Reflection list for given crite-

ria like hkl range, intensity, polarization and diffractometer angles. This can be useful as

a preparation for an experiment e.g. by selecting those magnetic reflections which show a

large chiral component in the Pyx term. The reflections which fullfil the given criteria are

shown in a table after clicking Create hkl list. By right-clicking on a respective horizontal

header the list can be ordered according to that parameter, either ascending or descending.

The reflection list can be saved in ASCII format which is directly readable by MAD or

NOMAD due to the comments marked by ’ !’.
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In addition to simple calculations as shown in the previous section, scale/extinction pa-

rameters and magnetic domains can be defined, which obviously affect the observed inten-

sities and polarization values. In case of a crystallographic site being shared by multiple

magnetic ions, user-defined magnetic form factors can be created, plotted and saved.

3.1 Global settings

The global settings of the application can be evoked from the Settings or Preferences

menu (depending on the platform). General parameters concerning the application, the

instrument, symmetry and the view can be found in the General tab. Most of the settings

are self-explaining. Note that the theme colors and the dark mode can also be set via the

shortcuts Alt + 1 to Alt + 8 from within the main window.

Under the Symmetry tab, the option Check special atomic positions assures that the user

does not define an atomic position (by mistake) which is too close to a special Wyckoff

position. If after generation of the unit cell, atoms of the same site reveal a distance

shorter than the one defined under Shortest allowed distance, the program will show a

warning. The option Constrain lattice parameters in powder fit will automatically add

constraints concerning the lattice parameters during Rietveld refinement depending on

the space group. The setting Constrain propagation vector in powder fit constrains e.g.

qy = qx for a tetragonal, trigonal (hexagonal setting) or hexagonal space group or e.g.

qz = qy = qx for a cubic or trigonal (rhombohedral setting) space group.

Under the Refinement tab different least-squares fit parameters can be set. The con-

vergence criterium is defined as the maximum parameter shift divided by its standard

deviation. The range in multiples of the peak FWHM can be defined for which the peak

profile will be calculated in a powder pattern. When the Calculate pattern in excluded

regions option is disabled, only the peak positions will be calculated and shown, but no

intensities will be calculated. This can be a convenient choice for low-symmetry struc-

tures with hundreds (thousands) of reflections in the high-Q region of the powder pattern.

The setting Ignore secondary phases for single crystal should be unchecked when those

secondary phases are only present in a powder diffraction pattern. It should be checked

when two nuclear and/or magnetic phases are actually present in the single-crystal sample
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and contribute to the same reflections.

All settings concerning the unit cell plot in the OpenGL widget can be found under the

Plot tab. Here the objects to be rendered can be chosen as well as the mouse sensitivity

for zooming and rotating the plot. Several options exist to adjust the rendering quality

which affect the fluidity with which you can manipulate the drawing. The level of mul-

tisampling can be set by the number of samples per pixel, which affects the rendering of

edges (smoother edges for increasing multisamples). The object resolution is a measure of

the number of vertices which are calculated for the creation of an object. The minimum

number is 3 and corresponds to a triangle in comparison to a circle with higher resolution.

In order to correctly render transparent objects, when they are aligned one behind the

other, the order is crucial. Since the perspective is constantly changed by the user, the

order of the transparent objects is automatically recalculated on-the-fly. For a large num-

ber of transparent object this means a lot of calculation cost, of course. Therefore, the

threshold for continuous reordering can be adjusted, the default value being 1000 objects,

e.g. 100 octahedra (each containing 8 transparent planes) and 200 spin envelopes. Above

this threshold, the order will only be recalculated when the mouse button is released after

dragging the perspective. In order to avoid too long calculation times when a very large

supercell with a lot of transparent objects is plotted, the automatic reordering can be

turned off with the second threshold value (default is 5000).

Under the Labels tab the position, scale and font size of the coordinate axes and legend

can be customized. It is also possible to enter individual translation values for the axes

labels. These settings are also saved in the *.xml file.

Figure 3.1: Global settings in Mag2Pol.
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3.2 Scale and extinction parameters

3.2 Scale and extinction parameters

The scale factor and extinction parameters can be set via the menu entries Structure→Scale

factor and Structure→Extinction, respectively. The scale factor is multiplied to the calcu-

lated intensities of Bragg reflections in order to be compared with the observed ones. The

extinction parameters xij build up the tensor x which allows the treatment according to

an empirical model which represents a compromise to treat both primary and secondary

extinction. It is also implemented in FullProf [14] and in ShelX [15] and has shown to

work well in practice. The extinction correction is given by

y =

(
1 +

pxanisoF
2
c λ

3

4 sin(2θ)(sin θ/λ)2

)− 1
2

(3.1)

where x is the anisotropic extinction parameter and Fc is the calculated structure factor.

p is 1e−3 for neutrons and 1e−6 for x-rays. xaniso is obtained by operating the tensor x

subsequently on the scattering vector (hkl):

xaniso =


x11 x12 x13

0 x22 x23

0 0 x33


hk
l



hk
l

 = x11h
2+x22k

2+x33l
2+x12hk+x13hl+x23kl

(3.2)

3.3 Domains and twins

An unlimited number of magnetic domains and structural twins can simply be added via

the menu Structure→Domains and twins (see demo video). The program differentiates

between S-domains and k-domains, see [16] for a review. For k-domains at least two

propagation vectors have to be set to which the magnetic domains (see below) can be

attributed.

For magnetic domains, first the number of different domains has to be set, which automat-

ically applies an even population between the domains. Then, the symmetry operators

(usually the ones from the paramagnetic space group which have been lost in the mag-

netic phase transition) have to be entered using the combo boxes. In addition, check

boxes can be activated to define inversion or chiral domains. The first simply reverses

every magnetic moment, whereas the latter takes the complex conjugate but keeps the

phase shift of the user-given Fourier components describing the magnetic structure. If a

symmetry operation is not included in the little group, i.e. it transforms +q into −q, the

program calculates the complex-conjugate and inverts the phase. That means that if a

magnetic structure breaks inversion symmetry and therefore two magnetic domains are

related by the inversion center, the chiral checkbox should not be checked. When only
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one propagation vector is present, then all magnetic domains are considered as S-domains.

When more than one propagation vector is entered, then each of the magnetic domains

can be attributed to a specific k-domain by choosing the arm of the propagation vector

star through the combo box with q1, q2, etc.

Structural twins are set up in the same way, however, in this case the rotation matrix

relating the (hkl) reflections of the different twins has to be given. For the calculation

of structure factors those rotations matrices will be multiplied to the observed (hkl) val-

ues and if the result corresponds to integer indices (± the propagation vector) it will be

considered as a contribution from another twin.

3.4 X-ray and magnetic form factors

3.4.1 Built-in form factors

In the present version of Mag2Pol the scattering length, absorption cross section, inco-

herent cross section and X-ray form factor of all elements and the magnetic form factors of

the 3d, 4d and actinide ions are implemented. The latter are described by the analytical

expression

fM (Q) = A exp(−as2) +B exp(−bs2) + C exp(−cs2) +D (3.3)

with s = sin(θ)/λ. The magnetic form factors marked with the letter M (e.g. MCo2 for

Co2+) consist of only spherical Bessel functions ⟨j0⟩. For the rare-earth elements addi-

tional magnetic form factors are implemented which are marked with the letter J (e.g.

JHo3 for Ho3+) which approximate ⟨j0⟩+ c2⟨j2⟩.

The atomic or X-ray form factor is given by

f(Q) =
4∑

i=1

ai exp(−bis2) + c (3.4)

The form factor is then corrected for anomalous dispersion which modifies it to

f(Q) = f0 + f ′ + if ′′ (3.5)

where the real and imaginary part of the anomalous dispersion f ′ and f ′′ are stored

wavelength-dependent in Mag2Pol. The complete list of built-in scattering lengths and

(magnetic) form factors can be accessed under Form factors→View list (see this demo

video). The list can be ordered either by element name, by atomic number or alphabet-

ically by right-clicking on the combo box and selecting the appropriate menu entry. By

selecting an element from the combo box the scattering lengths, cross sections and the

(magnetic) form factor coefficients will be displayed as well as a plot of the x-ray and
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3.4 X-ray and magnetic form factors

magnetic form factor as a function of sin(θ)/λ. Multiple form factors can be plotted by

clicking Keep before selecting another element (see Fig. 3.2). Parts of the plot can be

Figure 3.2: Example of the comparison of multiple form factors.

zoomed in by the usual controls of clicking and dragging, while the original view is reset

by a right click. The plot can be cleared by clicking Clear.

3.4.2 User-defined form factors

In some cases it is desirable to use a custom magnetic form factor, e.g. if the magnetic

form factor under question is not tabulated or if one crystallographic site is shared by

different magnetic ions. In this case Mag2Pol offers a simple method to add user-defined

magnetic form factors which can then be saved in the input control file. In order to

add (or delete) custom magnetic form factors, open the respective window under Form

factors→Manage user-defined (or the corresponding toolbar icon), where you will find

two tabs for the respective actions. Under Add either enter the form factor coefficients

and the scattering length manually or type in a linear combination of built-in magnetic

form factors. The number of elements is unlimited, however, the weights have to sum
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to 1. Interstitial sites can be handled through the occupation factor in the main win-

dow. Fig. 3.3 shows an example of a compound in which Co and Fe ions in bi- and

trivalent oxidation state share the same crystallographic site. The corresponding input is

Figure 3.3: Example of a user-defined magnetic form factor.

0.19*MCo2+0.27*MCo3+0.31*MFe2+0.23*MFe3, which is case-independent. A correct en-

try, i.e. the sum of weights is 1 and the (magnetic) ions have been recognized, is signalled

by green text (red otherwise). Note that you can only mix either only magnetic or only

non-magnetic ions. Instantly, the weighted magnetic and atomic form factor coefficients

and scattering length will be displayed as well as the plot of the form factors as a func-

tion of sin(θ)/λ. In order to save the new element a symbol has to be given. Any name

(different from any built-in element) can be used for the new element. Upon clicking Save

a pop-up window will inform the user, if the new element has been saved as magnetic or

non-magnetic ion.

Built-in form factors can be viewed in the complete list as well as under the Delete tab.

In the latter you can remove the selected one by clicking the button Delete.

3.5 User-defined basis vectors

For magnetic structures with higher symmetries it may be of advantage to use symmetry-

adapted basis vectors instead of manually putting constraints between the individual com-

ponents before refining the structure. Therefore, under Structure→Basis vectors up to 6

basis vectors can be defined (see Fig. 3.4). Once the use basis vectors check box is acti-

vated Mag2Pol will interpret the values under the Magnetic structure tab as well as in

the Fitting window as coefficients to be multiplied to the basis vectors. This is signalled

by the label <- BVs -> between the first and last 3 basis vector coefficients. Note that
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symmetry-adapted basis vectors can be deduced with the Irreducible Representation tool

which is described in Sec. 6.4.

Figure 3.4: Example of a user-defined basis vectors.

3.6 Mixed irreducible representations

Two one-dimensional representations can be combined to a two-dimensional one. This

can be achieved by setting the number of representations to 2 under the Symmetry tab

of the main window. This will duplicate the symmetry operations where the first half

corresponds to representation 1 and the second half to representation 2. The nuclear

symmetry can obviously not be changed, however, the magnetic symmetry should be set

by adjusting the (uvw) combo boxes according to the individual representations. Under

the tab Magnetic structure you can now attribute the indivudal real and imaginary parts

of the Fourier components to a respective representation by right-clicking on its value,

which will open a context menu. Here you can select either irrep1 or irrep2 as shown in

Fig. 3.5. Note that symmetry-adapted basis vectors of the irreducible representations can

also be mixed using the Irreducible Representation tool (see Sec. 6.4).

3.7 Magnetic form factor models

When defining a magnetic ion the default magnetic form factor corresponds to a spherical

magnetization density which is expressed by the radial integral ⟨j0⟩. Further magnetic
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Figure 3.5: By right-clicking on the value of the Fourier component it can be defined

according to which irreducible representation it transforms.

form factor models can be chosen for each magnetic ion individually by entering the

Multipoles window via Form factors→Multipoles (or its toolbar icon). Note that those

parameters (not belonging to the default model) can be refined in the fitting procedure

by activating the use multipoles checkbox when the refinement is done on flipping ratios.

When integrated intensities are analyzed the checkbox Refine magnetic form factor with

INT data should be activated in the settings.

3.7.1 Sum of radial integrals

This model still yields a spherical magnetization density and the magnetic form factor is

given by

fM (Q) = ⟨j0⟩+ w2 · ⟨j2⟩+ w4 · ⟨j4⟩+ w6 · ⟨j6⟩ (3.6)

with the ⟨jn⟩ being spherical Bessel functions and the wn refinable parameters. The

coefficients of the analytic approximation of the ⟨jn⟩ integrals are stored inside the program

and can be looked up in the form factors window (Form factors→View list). The analytical

approximation of the different spherical Bessel functions is given by

⟨j0⟩ = A exp(−as2) +B exp(−bs2) + C exp(−cs2) +D (3.7)

with s = sin(θ)/λ and

⟨jn⟩ =
(
A exp(−as2) +B exp(−bs2) + C exp(−cs2) +D

)
· s2 (3.8)

for n ̸= 0.

The resulting magnetic form factor is plotted together with the spherical ⟨j0⟩ in order

to point out the differences and can be exported as a PDF or ASCII file.
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3.7.2 Multipole expansion

If the data allows for a more sophisticated description of the magnetic form factor, the

deviation of the magnetization density from the spherical symmetry can be achieved by

a linear combination of basis functions. In Mag2Pol those basis functions are the real

spherical harmonics which describe the angular dependence of the magnetization density.

The radial dependence is calculated according to a Slater-type function (see Sec. 7.4 for

a complete description). The description of each combination of multipoles is always in

relation to a orthogonal local reference system, where for θ = φ = χ = 0 the local x axis

is parallel to the unit cell’s a axis, y is within the a-b plane and z is perpendicular to a

and b. By selecting the multipole expansion for a particular magnetic ion the coefficients

of the different basis functions (multipoles) can be set together with the Slater-type func-

tion coefficients and the local reference angles for each magnetic ion. Non-magnetic ions,

e.g. O2− can in principle be treated by first creating a new magnetic ion as described in

Sec. 3.4.2 and then using that ion in the multipole expansion.

The respective ion to which the local reference and the multipole/Slater coefficients apply

can be chosen in the combobox. The tab widget then offers a clearly arranged represen-

tation of the coefficients Cm
l , the Slater exponent n and the parameter Z, diveded into

monopole, dipoles, quadrupoles, octupoles and hexadecapoles. Note that the monopole

coefficient C0
0 represents the global magnetic moment of that ion and that the values in

the magnetic structure tab are ignored. As soon as a coefficient Cm
l is different from zero

the respective multipole can be plotted in the OpenGL widget (see Fig. 3.6, left panel).

When using many multipoles it can be difficult to see the individual ones clearly, so in

this case the tickboxes above the OpenGL widget can be used in order to only plot the

ones of interest. Clicking on color scale according to coefficients changes the color code in

dependence on the values of Cm
l . It is also possible to visualize the weighted sum of the

individual multipoles, which plots the angular dependence of the magnetization density

distribution (see Fig. 3.6, right panel). Since the magnetization density is non-spherical

the magnetic form factor in the right panel can now be plotted along a user-defined recip-

rocal lattice vector. It can also be chosen to show the amplitude, the real or the imaginary

part.

On clicking OK all parameters are saved for each atom. In the main window the (angular

dependence of the) magnetization density distribution around the ion can be visualized in

the unit cell, if the Multipoles and eventually the Local references check boxes are checked

in the Plot tab of the settings window. Note that the scale can be modified by the spin

and atom plot scales, respectively.

A demo video can be seen here.
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Figure 3.6: Multipole window allowing to the set the coefficients of the multipole ex-

pansion of the magnetization density. Left: Visualization of the individual orbitals with

positive and negative lobes. Right: Weighted sum of the individual orbitals.

Figure 3.7: Multipole expansion of the magnetization density for each magnetic ion in the

crystallographic unit cell (arbitrary population coefficients).
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3.7.3 Orbital expansion

The relation between multipole population parameters and orbital occupancies can be gen-

eralized as shown in [17] for which the magnetization density distribution can be expressed

in a similar way as in the previous section, but by using well-defined orbitals centered at

the atomic position. The angular dependence can be chosen between 2p, 3d, 4f and a

hybridized sp orbital, while the options for the radial dependence are the tabulated ⟨jn⟩
values, a hydrogen-like orbital or a Slater-like orbital as in FullProf. Note that the

coefficients Cm
l are normalized before being converted to the multipole population param-

eters (see Sec. 7.5) for which a single non-zero coefficient does not have any effect in a

least-squares refinement.

3.8 Orientation matrix

As mentioned briefly in Sec. 2.7 the orientation matrix of a Cryocradle experiment is nec-

essary to calculate the sample orientation for each (hkl) reflection. In other geometries

the orientation matrix is necessary e.g. for calculating the absorption correction or the

diffractometer angles. This UB matrix can either be entered manually in the window which

opens by clicking Geometry→Orientation matrix or by selecting Get UB in that window.

Here the individual observations with their respective angle values after centering can be

entered manually or a list of reflections can be loaded by clicking Browse. The program

reads *.dat files which are generated and filled by the MAD centering commands on the

instrument D3. The refinement of the UB matrix is done according to the formalism pre-

sented by Busing and Levy and is based on the conventions of the instrument given in the

Geometry→Instrument menu, see next section. The positioning of the sample with the

Cryocradle setup does not correspond to the bisecting geometry as for standard four-circle

geometries due to the fact that the angle ω is fixed. The positioning by using the angles χ

and ϕ basically correspond to a non-zero ψ value (ψ being the angle around the scattering

vector, which is 0 in the bisecting geometry). Fig. 3.8 shows the corresponding window

for calculating and refining an experimental UB matrix after the centered reflections have

been read from a file.

The refinement is presently reserved for the lattice parameters only (by activating the re-

spective check boxes), i.e. the wavelength cannot be varied. The symmetrical constrains,

e.g. a = b and γ = 120◦ are automatically set and fixed from the space group. By clicking

the Refine button a least-square refinement will be started, where the initial orientation

matrix is calculated form the first two reflections in the list and then refined on all obser-

vations.
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Figure 3.8: The experimental orientation matrix can be calculated and refined from a

number of observed reflections.

The results of the calculation/refinement are shown in the text field and consist of the

initially calculated UB matrix, a list of all observations and their observed and calculated

angles, the refined UB matrix, the refined lattice constants including their respective stan-

dard deviations and the reduced χ2. By clicking OK the refined UB matrix will be passed

on to the previous window, which can than be saved by clicking OK on the latter.

Another possibility is to set the orientation matrix by choosing two vectors - either direct

or reciprocal - pointing along the positive z axis and the positive x axis of the instrument

(i.e. according to the definition of the instrument geometry), respectively. The corre-

sponding UB matrix will be calculated by clicking on Calc UB. If the given vectors are

not perpendicular (2-digit precision in reciprocal Å), the program will show a warning. It

is possible to add an offset on ω (rotation around the vertical axis), χ (rotation around

the beam axis for ω=0) and φ (rotation around the vertical axis for χ=0) which will au-

tomatically update the calculated UB matrix. Note that the rotation senses of the ω, χ

and φ angles also follow the definition of the actual instrument geometry.

If a crystal model has been setup in the Sample info window (under Absorption) (or in

the Data reductioni window), it will be shown in a 3D plot on the right-hand side of the

window (see Fig. 3.9). The usual OpenGL controls like rotating, zooming, panning and

changing the light direction (Alt + rotating) are available. The plottable objects can be

switched on/off using the checkboxes on top of the 3D plot, which can be exported to a
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*.png file by clicking on the export button. Recalculating the UB matrix from the given

sample orientation (through the 2 definable vectors) or by moving the angle sliders will

update the sample orientation in real time.

Furthermore, it is possible to visualize the successive rotations of the sample when posi-

Figure 3.9: Orientation of the 3D sample model with respect to the Busing-Levy frame

(colord axes). The instrument geometry definition is taken into account for the visualiza-

tion.

tioning it for a particular Bragg reflection. In addition, the scattering vector, the incoming

beam and the diffracted beam will be shown. This can only be achieved, when the UB

matrices between the main window and the UB window are synchronized, i.e. the UB

window was just opened without modifying the orientation matrix. Then, when calcu-

lating the angles and structure factors of a Bragg reflection Q in the main window, the

sample will be positioned in the 3D plot of the UB window. If one wishes to see the final

orientation only, the animate checkbox can be unchecked before clicking Go! in the main

window.

3.9 Instrument

All instrument angle calculations are based on the definitions given in theGeometry→Instrument

menu (Fig. 3.10). On the one hand it is necessary for calculating the vertical sample axes

for a given (hkl) reflection for polarization matrix calculations, on the other hand it is

needed by the absorption correction module in order to calculate the beam path lengths

in the sample (see Sec. 4.2).

Five ILL single-crystal diffractometers (D3, D9, D10, D19, D23) can be selected from the
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combo box and their axes definitions, angle rotation senses and standard angle limits will

be automatically set. It is also possible to either change the definitions for another in-

strument or to choose a Custom instrument. The angle definitions are taken with respect

to the conventions of Busing & Levy [18], i.e. the incident beam is directed along the

positive y axis, z is the vertical axes and x completes the right-handed coordinate system.

E.g. the definition x: -x, y: +y, z: -z means that the x axis according to Busing &

Levy is actually the −x axis according to the instrument’s definition. In this example the

reference frame is rotated by 180 degrees around the y axis. In case the instrument axes

definition does not coincide with the Busing & Levy convention the instrument orientation

matrix is internally transformed before the calculation of the diffractometer angles. The

scattering geometry can be chosen between normal beam and 4 circle as well as Cryocradle

for D3. In 4-circle geometry the chi quadrant in which the instrument performs should

be given, but is automatically set to the standard value for the ILL diffractometers. The

calculated angles are converted back to the instrument’s convention with respect to the

rotation senses and whether the neutrons are diffracted to the left or to the right. The

diffraction direction is taken in the reference frame of the neutron, i.e. standing at the

source and looking towards the sample. The rotation sense of the angles θ, ω and ϕ (ϕ for

χ=0) are called clockwise or anticlockwise when viewed from the top. The sense of χ is

defined for ϕ=0 and looking towards the source. These definitions are shown as tooltips

when hovering the mouse above the respective combo boxes. The angle limits are used in

order to calculate the exact position of the sample in case the bisecting scattering geome-

try cannot be achieved and/or another chi quadrant has to be tried. Note that the offsets

are not yet used.
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Figure 3.10: Instrument axes and angles definitions used for the calculation for the sample

orientation at a particular (hkl) reflection.
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4 Fitting

The main purpose of Mag2Pol is the refinement of a nuclear and/or magnetic struc-

ture model to different kinds of data sets: spherical neutron polarimetry data, flipping

ratios, integrated intensities from a monochromatic single-crystal diffraction experiment

and powder diffraction patterns. Correlated refinements can be done in any combination

of the previously mentioned data types. After the structural data, the magnetic struc-

ture model, magnetic domains, scale factor and extinction parameters have been entered

and the unit cell has been successfully generated and visualized, one can proceed to the

refinement module by clicking Fit→Fit or the icon in the toolbar.

4.1 Loading raw data

The raw data are loaded in the Data tab using the respective buttons. In the present

version of Mag2Pol the accepted data types are

• D3 *.fli files containing the polarization values of the individual polarization matrix

entries and/or the flipping ratios

• D3 raw data Numors

• FullProf *.int files containing (a) integrated intensities of integer reflections plus

eventually two propagation vectors corresponding to +q and −q or (b) flipping ratios

together with the beam polarization and the orientation matrix.

• *.col files as an output of a RACER integration [19] of two-dimensional detector

data

• *.fsq files as an output of a COLL5 integration of single-detector data

• *.sf files as an output of a CCSL program

• *.bra files as an output of a D19 large-detector integration

• powder data in different formats (see below)
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When data files have been successfully loaded a message will be displayed in case of po-

larized neutron data and a list will appear in the case of integrated intensities and powder

patterns. By right-clicking on a list entry the wavelength, source and weight can be ad-

justed or the loaded data set can be deleted (note that the wavelength and source of powder

patterns can be entered in the respective tab, which will be explained in Sec. 4.5). When

loading *.fli files the program will detect if the data has been collected in polarimetry or

flipping ratio geometry of D3 and will set the corresponding checkbox (Refine on flipping

ratios) and disable the spin-filter related information eventually. In case of flipping ratio

data the checkbox Use multipole expansion appears, which if set will add a multipole tab

to the fit window. If flipping ratio data were loaded from a *.fli file the data reduction

window will open, which will be explained in more detail below for integrated intensity

data. The loaded data can be viewed by clicking on View data. Right-clicking on a vertical

header opens a context menu, which permits to delete a single reflection (Delete) or all

reflections of the same (hkl) values (Delete all). This is useful to remove nuclear reflec-

tions, which have been measured to calibrate the efficiency of the 3He spin-filter cell, from

a list of polarization matrices. Activating the checkbox Refine nuclear structure for any

data type will add an Atoms tab containing the atomic positions, isotropic temperature

factors and occupation factors as well as the scale and extinction factors. In the case of

integrated intensities the checkbox Purely magnetic scattering should be checked, if the

loaded data was obtained from a subtraction of a nuclear background.

When opening a *.col, *.fsq, *.sf, *.bra or a flipping ratio *.fli file a data re-

duction window will open (see Fig. 4.1), in which the user can merge the loaded data with

respect to a given space group (at the beginning the space group from the main window

is automatically set). The reflections will be shown regrouped and the Rint value will

be printed together with reflection statistics (unique, symmetry inequivalent, forbidden

reflections). The internal R value is calculated according to

Rint =

∑
n
In − Ī∑
n
In

(4.1)

and the sum is taken over all n reflections without previously averaging repeated obser-

vations. Forbidden reflections can be excluded from the calculation. The reflection list is

ordered by scattering angle by default, but it can be ordered with respect to h, k, l, I/R,

dI/dR or 2θ by right-clicking on the corresponding horizontal header and by choosing ei-

ther ascending or descending from the sort menu. A particular reflection can be searched

by opening a find dialog using the Ctrl/Cmd+Shift+F shortcut. The (hkl) indices can by

transformed by entering a transformation matrix in the upper-right part of the window
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4.1 Loading raw data

and then clicking Apply. Any further application of different transformation matrices will

be applied to the original indices and the applied changes can be reverted by clicking the

corresponding button.

The data can then be transfered to the fit window or be exported in a format correspond-

ing to a FullProf *.int file (this is also possible for flipping ratio data). Furthermore,

for integrated intensity data a second data set can be subtracted from the first one by

clicking on Subtract dataset, which is useful for removing the nuclear contribution from

q = 0 reflections. If the second data set lacks reflections which are present in the first data

set, there are two options: either ignore (delete) the corresponding reflection or treating

the missing reflection as I = 0. The latter can be convenient, if a low-temperature mag-

netic data set contains (hkl) reflections which are forbidden and have not been measured

in the high-temperature nuclear data set.

Figure 4.1: Data reduction window permitting to merge integrated intensities with respect

to a given space group.

From within the data reduction window an absorption correction of integrated intensities

can be applied for different sample shapes, see next chapter.

The integrated intensity data transferred from the data reduction window to the fit window

as well as the data directly loaded from an *.int file will be shown as a list in the Integrated

intensities section. A right-click on a data set offers different options in a context menu,

e.g. deleting or replacing the data set. The replace option is useful if one wants to use the

same structure including the scale factor for the refinement of another data set. Note that

deleting a data set also deletes its corresponding scale factor. Other parameters which can

be addressed from the context menu are the source, the wavelength and the weight of the
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data set in the least-squares algorithm.

Before loading powder patterns the corresponding format of the file has to specified in the

drop-down menu. The different options are

• Mag2Pol format. It consists of a header with title, wavelengths, ratio and temper-

atures followed by the data in values of 2θ, counts and sigmas. Powder patterns in

other formats can be exported in this format by clicking on Save data after successful

opening.

• XYSIGMA corresponding to FullProf Ins = 10

• D1A, D2B corresponding to FullProf Ins = 6

• D1B, D20 corresponding to FullProf Ins = 3

• Free Format corresponding to FullProf Ins = 0

• DMC, HRPT corresponding to FullProf Ins = 8

• GSAS TOF corresponding to FullProf Ins = 12

• ISIS TOF corresponding to FullProf Ins = 14

When a wrong format was specified an error message will be shown, otherwise, after

successful opening a Patterns tab will appear in the tab widget in which the loaded data

can be viewed and analyzed (see Sec. 4.5). A successfully opened diffraction pattern of

any format can be exported into Mag2Pol format with *.m2p extension. The data is

stored in three columns - 2θ, counts and σ - and is preceded by a header containing

the lines TITLE, WAVE, TEMP, COMP (composition parameter x, e.g. in AxB1−x) and the

corresponding metadata. Further lines might be added in future versions while obviously

maintaining compatibility. A pattern is exported by selecting it in the table of loaded

patterns and clicking Save data. Input dialogs will pop up in which the metadata can be

entered. As for integrated intensity data, a right click on the data set evokes a context

menu with the possibility to delete or replace the data set as well as to change the weight

in the least-squares algorithm.

4.2 Absorption correction

4.2.1 Simple sample shapes

An absorption correction can be applied for spherical sample shapes and cylindrical sam-

ple shapes with normal-beam geometry, which is based on [20]. The linear absorption
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4.2 Absorption correction

coefficient is automatically calculated based on the structure model and displayed in the

according box, but of course, one is free to enter whatever value. The calculation is done

according to:

µ =

∑
i
oi(σi,a · λ/1.798197 Å + σi,inc)

V
(4.2)

where the sum is done over the atoms i of the unit cell with volume V . oi is the occupa-

tion, σi,a is the absorption cross section (at λ = 1.798197 Å) and σi,inc is the incoherent

scattering cross section of atom i. The incoherent scattering cross section is wavelength

independent for most elements, with a notable exception being hydrogen for which it is

given by

σH,inc = 19.2 · λ+ 20.6 (4.3)

with λ given in Å resulting in σH,inc in barns [21].

After setting the radius of the sample in mm one only needs to click Apply to perform the

absorption correction. The internal R value will directly be recalculated. The corrected,

uncorrected and normalized uncorrected data can be verified under Compare. The button

Undo permits to remove the applied correction.

4.2.2 Special sample shape

Mag2Pol offers the possibility to index the bounding faces of a convex crystal shape

based on a sequence of picture frames which can be loaded into the program (note that a

crystal model can be set up blindly even without such frames, see hints below). This is

done within an interactive OpenGL widget, which can be opened by selecting the special

sample shape and clicking Set faces. When first opened the crystal model utility should

show a red crosshair on a white or black background (for dark mode off/on, respectively).

Depending on the platform (as seen for Linux and Windows) borders in a different color

can be present, which should be removed by right-clicking witin the widget and selecting

Adjust size (furthermore Linux and Windows machines display a wrong aspect ratio of

the frames which is not a problem for the following treatment). The program assumes that

the picture frames are taken during a successive rotation of the sample around the φ axis

for 4-circle geometries or around the ω axis for normal-beam geometries. For the first, it

is necesssary to indicate the χ value at which the frames have been taken. Before opening

the picture files the lower and upper angles spanned by the rotation should be entered

in the corresponding boxes. When selecting the files in the file browser, they should be

ordered according to angles with the first file selected corresponding to the lower angle.

Since the camera position and rotation can be general, it should be stated to which diffrac-

tometer axes the right and up directions of the OpenGL widget refer to. The file names

and camera parameters will automatically be saved in a crystalFrames.info file which
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can conveniently be chosen for the next time. The diffractometer axes should be given

according to the convention of Busing & Levy, i.e. the incoming beam is along the positive

y axis and the z axis is vertical, x completes the righthanded set. The orientation matrix

will internally be transformed according to the instrument’s definition (see Sec. 3.9). On

the ILL instruments the camera is mounted on the omega table and is pointing upwards.

With the neutrons entering from the top part of the taken picture the correct settings for

this geometry are those which are loaded by default, i.e. right = +x, up = −y. The frames

are then taken by rotating around the φ axis with χ = 90◦ and the sense of rotation is

calculated based on the instrument’s definition.

Camera and sample offsets can be set in the Offsets tab on the right. x sample off-

sets should be set, when a picture close to φ = 0 is viewed, while y sample offsets can

be seen for φ ≈ 90. The buttons for ±90 or ±180 rotations can be used for finding the

offsets conveniently. A z sample offset concerns the height along the sample pin. The

camera offsets refer to the lateral misalignment of the camera and its rotation around the

z axis. The goal is to have the crystal’s center of mass in the center of the crosshair. In

the View tab it is important to set the zoom factor so that the radius of the crosshair (in

mm) corresponds roughly to the real crystal dimensions.

The frames can be viewed by dragging the horizontal slider below the OpenGL widget

or by using the buttons below it. The play speed can be adjusted and the loop checkbox

can be set, if you want to see a continuous rotation.

In order to add a plane to the crystal model, one has to rotate the crystal to a posi-

tion in which the face is parallel to the view direction. In this position simply click and

drag a line along the edge, which will add a plane (converted to hkl) to the table. The

length of the line is not very important and only serves for drawing unbound planes as

a square having the edge length according to the drawn line. By adding more planes in

different sample positions the program will redraw the bound volume and show the model

on top of the picture. Note that it is of course possible to draw a sample model without

having loaded any frames. In that case, it is recommended to change the plane color under

the View tab to a different color than the background. First, one should draw e.g. four

lines in the shape of a square around the crosshair, then move the φ slider by +90◦ or -90◦

and draw two horizontal lines above and below the center position, which should create a

closed volume.

In order to highlight a plane simply click on it in the table or in the model. When a

parameter in the table is highlighted, it can be adjusted using the horizontal slider or a
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new value can be entered directly. The crystal model will be updated instantaneously.

If a plane is actually needed to draw the smallest possible volume will be shown with a

yes or no in the last column of the table. Planes can be removed by right-clicking the

vertical header and selecting Delete. Multiple planes can be deleted simultaneously. For

very irregularly shaped crystals it may be more intuitive to uncheck the Hide planes be-

hind picture option in the View tab. An example of a complex crystal shape is shown in

Fig. 4.2 and a tutorial video can be seen here. By clicking OK the created planes will

Figure 4.2: Complex crystal shape containing 19 limiting faces.

be transfered to the Data reduction window. Note that the planes are only saved when

at least 4 used planes are present. Unused planes are not saved. Mag2Pol will auto-

matically calculate the corresponding diffractometer angles for every measured reflection

based on the instrument definition and will determine if a non-zero ψ angle or a different

χ quadrant was necessary to measure a particular reflection. Furthermore, the number of

integration samples should be given along the a, b and c axes of the sample by clicking

on Set grid. The grid points will be distributed according to the Gaussian integration

procedure described in [22].
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Once all the necessary information are entered, the absorption correction is done like

for simple sample shapes by clicking the Apply button. By clicking on any hkl index in

the table the orientation of the crystal model and the integration points are shown together

with the diffractometer axes and the incoming/outgoing neutron beams (see Fig. 4.3). The

planes of the model which are intersected when diffracting from the origin are marked by

orange edges. The diffractometer angles are shown below the OpenGL widget together

with the average path lengths along the incoming (r1) and outgoing beam (r2). The

average transmission T is approximated by a Gaussian integration [22] according to

T =

∫
V

1

V
exp[−µ(r1 + r2)]dV

≈
nx∑
i=1

ny∑
j=1

nz∑
k=1

(b− a)[d(xi)− c(xi)][f(xi, yj)− e(xi, yj)]RiRjRk1/V exp[−µ(r1 + r2)],

(4.4)

where the a, b, c, d, e, f are the corresponding limits of integrations and the Ri, Rj , Rk

are the respective weights which are taken from [23]. The visualization of the scattering

geometry is animated by default, i.e. the successive rotation of angles will be shown. By

unchecking animate the final diffraction position will be shown immediately. For a more

fluid rendering the grid points can be omitted in the rendering process. The absorption

Figure 4.3: Orientation of the sample for a given (hkl) reflection within the Busing-Levy

frame (colored axes). The diffractometer angles are give together with the average beam

paths inside the sample and the transmission factor.

correction in Mag2Pol has been compared to the subroutine AVEXAR of the CCSL
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subroutine library for normal beam and 4-circle geometries. The results are identical

within rounding errors starting from nx = ny = nz = 3 as can be seen in Fig. 4.4.

0 2 4 6 8 10
0.88

0.9

0.92

0.94

0.96

Figure 4.4: Transmission as a function of integration points nx = ny = nz for three

different Bragg reflections calculated by Mag2Pol and CCSL.

4.2.3 On-the-fly absorption correction

The absorption correction mentioned in the section above can be applied to correct the

dataset of integrated intensities which was opened in the data reduction window. In that

case the correction factors are applied to each measured (hkl) reflection before an eventual

merging with respect to the given space group. The corrected data can directly be used

in the analysis or they can be exported into an *.int file.

It is also possible to use the convex-hull crystal model to do an on-the-fly absorption

correction, which is useful if one wants to refine the occupation of a heavy absorber as it

influences both the absorption through the linear absorption coefficient and the scattering

potential through the scattering length (e.g. incomplete 11B or 160Gd substitution). This

possibility allows for a self-consistent analysis of the data. In order to activate this feature

a crystal model needs to be present before entering the fit window, which can be done

by opening the Sample info window (see Sec. 6.1) and clicking Edit under the Absorption

tab. In that case, when the fit window is entered the option On-the-fly absorption cor-

rection becomes visible below the loaded integrated intensity data. When it is activiated

the program will calculate the neutron beam path lengths for all the reflections only once

before starting the refinement iterations. In each iteration the linear absorption coefficient

may be different, if the atomic occupations are refined parameters. Note that the use of

this feature is even possible for multiple integrated intensity files as long as the data were
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recorded in the same instrument geometry (e.g. different wavelengths).

If the occupation of a heavy absorber is uncertain and needs to be refined, the recom-

mended procedure is the following:

In a first step, the integrated intensities should be reduced in P1 or P -1 symmetry (the

beam path lengths are identical for Friedel pairs, however, small deviations may be possible

in the calculation due to precision errors) and loaded as an *.int file for the refinement.

After activating the on-the-fly absorption correction check box, the nuclear structure re-

finement can be done as usual.

In a second step, the refined nuclear structure from the first step should be used to apply

the absorption correction on the raw data which are then eventually merged and exported

(as explained in Sec. 4.2.2). The last step consists in refining the nuclear structure to the

corrected and merged data set of step 2 (without the on-the-fly option), which should give

similar results as in the first step, but with better agreement factors due to a reduced

number of observations (due to the merging of equivalent reflections).

4.3 Correction for the spin-filter efficiency

Usually the efficiency of the 3He spin-filter cell is monitored by measuring e.g. the polar-

ization Pzz on a purely nuclear Bragg peak - which is known to be 1 - several times a day

during the experiment. The reduction from the expected value is due to the initial polar-

ization of the neutron beam (which can be set in the Settings menu) and the spin-filter

efficiency. In the case of a loaded *.fli file the program analyzes the lines which signal a

cell change and the time of the respective observations to show the decrease of efficiency as

a function of hours. On D3 depending on the used cell the decay is usually between 10 and

20% per day. The reflection on which the calibration has been performed throughout the

experiment and the polarization canal has to be selected followed by clicking Apply. The

polarization data will now be corrected with respect to the decaying spin-filter efficiency

according to

Pcorr = Pmes ·
P0

Pcell
(4.5)

and repeated reflections will be merged (P0 is the polarization of the incident neutron

beam, note that setting this value to 1 in the settings of the program will correct the

data also for the initial polarization). A more precise merging is possible, if the respective

raw data Numors are put in the same folder as the *.fli file. Like this the individual

counts (background - peak - background) can be summed up and weighted by the respec-

tive counting times. Otherwise, a weighted average will be calculated from the standard

deviations given in the *.fli file. In order to interpolate the spin-filter efficiency for any
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4.3 Correction for the spin-filter efficiency

given time an exponential decay function of the form

P (t) = tanh[O · P0,He · exp(−t/T1/2)] (4.6)

is used, where O = λ · l · p · 7.282 · 10−2 is the cell opacity at room temperature. The wave-

length and the cell pressure p are fixed, while the halflife T1/2 and the initial polarization

of the cell P0,He are refined. The results can be seen by clicking on View cell efficiency,

which opens a window similar to the one shown in Fig. 4.5. The different cells recognized

Figure 4.5: Visualization of the spin-filter efficiency decay as a function of time.

from the entries in the *.fli file can be chosen from the combo box. The legend shows

the name of the cell as well as the refined values including standard deviations for the

initial cell polarization and the halflife.

The corrected data can be saved from the fit window in order not to repeat this proce-

dure.

Note that when chiral or nuclear-magnetic interference scattering is present, the polar-

ization data should only be corrected to the spin-filter efficiency and not to the initial

polarization (i.e. the P0 value of the incident beam needs to be entered in the Mag2Pol

settings) as the respective entries contain terms which are dependent on the initial neu-

tron polarization and terms which are not. In order to analyze the raw data the checkbox

Refine on uncorrected data using cell efficiency should be activated before you hit the

button Apply. The program will still take into account the cell efficiency at a given time

of an observation, but it will be used in combination with the initial neutron polarization

to calculate the respective entry of the polarization matrix. In this case no merging of

reflections is possible.
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Loading Numors directly is intended for a special type of measurement, where the ini-

tial neutron spin is rotated within the local y-z plane. The positions and amplitudes of

the minima and maxima allow important conclusions concerning the magnetic structure.

In this case the polarization value (including the time of the observation) as well as the

directions of the initial neutron polarization and analysis vector are extracted from the

Numor files. As no information is present concerning any potential spin-filter cell changes

only those data should be loaded which have been measured with the same cell. The

correction with respect to the cell efficiency is done as described above (note that for a

final polarization vector within the y-z plane no chiral scattering is present).

4.4 Refinement flags and constraints

All the magnetic ions defined within the magnetic structure will be listed in the same

order under the Magnetic moments tab as M1, M2, .... The magnetic domains are shown

under the Domains tab together with their corresponding symmetry, an eventual keyword

signalling an inversion or chiral domain and their population. In the case of a multipole

refinement on flipping ratio data, the coefficients Cm
l and the Slater coefficient Z are

refinable parameters as well. By activating the checkbox next to a respective value, this

parameter will be considered as a refined variable. Nuclear structure parameters can be

refined, when the checkbox Refine nuclear structure is activated in the Data tab, which

will insert a new tab called Atoms including the positions, thermal and occupational

parameters, scale factor and extinction coefficients. Anisotropic displacement parameters

can be flagged by chosing the set betas context menu entry after right-clicking an isotropic

temperature factor. Constrained Bij values and fit flags are disabled if they are constrained

by symmetry.

Linear constraints can be set under the Constraints tab by chosing the variables and

relations from the combo boxes and entering the proportionality factors and summands

by hand. M1 refers to the whole vector of magnetic moment 1, |M1| refers to the modulus of

the moment, whereas Mr1 and Mi1 would denote the real and imaginary part, respectively

(note that vector quantities can only be constrained to other vector quantities and that

a moment modulus can only be constrained to another moment modulus). In the case

of non-zero real and imaginary components, Mag2Pol will constrain Mr and Mi to be

perpendicular, if they are not defined as parallel. If the real components are refined, the

imaginary vector will be adjusted and vice versa. If both real and imaginary components

are refined, the imaginary vector will be adjusted after each iteration.
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Figure 4.6: Anisotropic displacement parameters and the visualization of thermal ellip-

soids.
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The constraints take the form of

p1 = a · p2 + b (4.7)

where p1 depends on p2. If you choose the equal sign, the parameter p1 is regarded as a

constant (in relation to parameter p2) and should therefore not be refined. For relations

’greater than’ or ’smaller than’ the constrained parameter p1 should be marked as a refined

parameter. If the multiplication factor a is 0, then p2 is a dummy parameter which is not

necessarily refined and p1 is directly related to the scalar b. If |a| > 0, then p2 needs to

be set as a refined parameter as well (note that errors will be shown as pop-up warnings).

The keyword various for parameter p1 can be used to define multiple constraints. By

choosing various a button will appear to the right which permits to select various param-

eters from a list which will be constrained to p2 (see Fig. 4.7).

In the present version of Mag2Pol up to 20 constraints can be set. In case of multiple

magnetic domains or structural twins, the population of the first domain/twin is automi-

cally set to 1 minus the rest in each iteration. Constraints can be deleted by right-clicking

the parameter to be constrained and then clicking Delete.

Figure 4.7: Multiple parameters can be selected after choosing various.

Note that constraints on atomic positions due to special Wyckoff sites, e.g. (x x + 1
2 z)

or (x 2x 1
2), do not need to be set by the user, because Mag2Pol will consider them

automatically. The same applies to anisotropic temperature factors of atoms on special

sites.

42



4.4 Refinement flags and constraints

Simple constraints, i.e. of the form p1 = p2, can directly be set in the Atoms, Moments

and Domains tabs by right-clicking the respective label and evoking context menus as

shown in Fig. 4.8. Note that the parameter to which one wishes to constrain needs to

be placed higher in the atom/moment/domain/twin list or it needs to be in a phase with

lower index. E.g. the position of atom 3 in phase 2 can be constrained to atom 2 of the

same phase or to atom 4 of phase 1. Parameters being lower in the list are automatically

grayed out in the context menu.

In the case of atoms the parameters which can be constrained are

• position: x, y and z fractional coordinates

• B: isotropic temperature factor

• anisotropic B: all anisotropic displacement parameters

• occupation: the occupation factor

• all atomic parameters: all of the above

If the parameter in questions is a magnetic atom, the options are

• moment: all real and imaginary components

• moment modulus: the modulus of the moment

• real part: the parameters belonging to the real part of the complex magnetic moment

• real part modulus: the modulus of the real part of the complex magnetic moment

• imaginary part: the parameters belonging to the imaginary part of the complex

magnetic moment

• imaginary part modulus: the modulus of the imaginary part of the complex magnetic

moment

• phase: the magnetic phase

• all magnetic parameters: all real and imaginary components as well as the magnetic

phase

In the case of domains and twins the population can be constrained to any other do-

main/twin population with a lower index similarly to what was explained above concerning

atomic sites. Note that constraining a domain (twin) population to the first domain (twin)

population equally distributes the remainder of the other domain (twin) populations to 1

(i.e. 1 minus the rest) on the constrained domains (twins), which is not supported when
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using constraints under the Constraints tab. Setting a constraint in this way will disable

the manual editing of the corresponding parameters and fit flags. In order to quickly find

to which parameter a constraint is set, the corresponding menu fonts are set in italic. A

constraint can be removed by unchecking it. Some constraint combinations will be auto-

matically summarized as a different one, e.g. if the imaginary part of a magnetic moment

is constrained after the real part was already constrained, then the constraint will be found

under Constrain moment.

Changing a parameter will automatically update the parameter(s) which is/are constrained

to it (both for constraints under the corresponding tab as well as for simple constrained

which are set via context menues).

Figure 4.8: Simple constraints can conveniently be set using context menues.

4.5 Powder patterns

When at least one powder pattern has been loaded, the Patterns tab appears which is

shown in Fig. 4.9. The left part of the tab features the pattern plot with the corresponding

plot controls above it, while the scroll area on the right side contains all necessary param-

eters and fit flags separated into different categories. The category labels, e.g. Geometry,

Background, etc., contain further options which can be evoked by right-clicking the label

which opens a context menu. The context menu generally contains a list of loaded patterns

and contributing phases in order to set constraints between them (see Sec. 4.5.6). Further

options of certain categories are explained below. Note that the parameters depend on

the type of data loaded, i.e. if it was taken on a constant-wavelength or a time-of-flight

diffractometer.
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4.5 Powder patterns

Figure 4.9: Pattern tab within the Fit window in which all parameters can be set which

are necessary for the Rietveld refinement.

4.5.1 Plot controls

The plot always shows the observed data points in red, the calculated pattern in black and

the difference between the two in blue. Furthermore, the positions of nuclear and magnetic

Bragg reflections calculated from the underlying model(s) are shown as green markers

between the data and the difference curve. Like in other 2D plots hovering the mouse

over data points shows the respective coordinates, while hovering over the peak markers

reveals the scattering angle (or time of flight), the Miller indices and the multiplicity of

the Bragg reflection. When more than one pattern file was loaded, one can switch between

them by choosing from the combo box in the upper-left corner. The two buttons to the

right of the combo box toggle the background and excluded regions mode which will be

explained in Secs. 4.5.3 and 4.5.4. The next 3 buttons toggle the plot grid, the legend

and the χ2 value on the plot, whereas the last button exports the plot into either a pdf

or an ASCII file taking into account the actual zoom (note that for the ASCII output the

excluded angles and peak markers are labelled with an asterisk). The plot boundaries for

the 2θ and counts axes can be set further to the right. Those boundaries will also be used

for the plot in the Fit tab. They can be reset to the optimal values by right-clicking on

any of the 4 values and then clicking reset boundaries.
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4.5.2 Geometry

The Geometry section concerns the basic information of the used instrument like the

source (neutron or x-ray) and the wavelength. Note that constant-wavelength (CW) and

time-of-flight (TOF) instruments in Debye-Scherrer geometry are currently supported in

Mag2Pol. For CW patterns the λ/2 contamination or the Kα2 line can be entered

in the λ2 field with the corresponding intensity ratio between λ1 and λ2. When x-ray is

selected, a right-click on the λ1 value allows the selection between different frequently used

x-ray Kα1,2 lines. The values K and 2θM are only needed in the x-ray case in order to

calculate the monochromator polarisation within the Lorentz factor (see Sec. 7.7.1). For

TOF patterns the detector bank angle 2θB has to be given. From the Geometry context

menu the instrument configuration of different ILL and ISIS instruments can be loaded,

which include the wavelength, the resolution, the peak shape and asymmetry parameters

for constant-wavelength diffractometers as well as time-of-flight, detetor bank, rise and

decay and peak shape parameters for TOF. This is a convenient way of setting up a

starting point of the refinement, see Fig. 4.10.

Figure 4.10: Selection of predefined instrument configurations.

4.5.3 Background

There are different ways to introduce the background of a powder pattern. The first is to

give a list of points between which a linear interpolation is calculated. In order to do so the

background mode needs to be activated by clicking on the first button next to the pattern

file name. If a background is already defined it will be shown as green squares connected

by green lines (see e.g. Fig. 4.9). A background point is simply added by left-clicking on

the pattern. A green square will be added to the plot and the corresponding 2θ value and

counts will be added to the table on the right. An already drawn point can be moved by

placing the mouse over it which will turn the mouse cursor into an open hand symbol.

Now simply click and drag the background point to the desired position. The coordinates
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4.5 Powder patterns

of each point can also be modified by directly editing them in the table. A background

point can be deleted by right-clicking it. The pattern will be calculated using the newly

defined background after leaving the background mode, i.e. by clicking the corresponding

button.

The background can also be modeled with a polynomial function of different degrees or

with a Debye-like model (see Sec. 7.7.1.7 for more information). In order to change the

background type, simply right-click the Background label in the scroll area and select one

of the diffent models, see Fig. 4.11. Note that when you select polynomial (6 coeffs) and

you have manually introduced points before, the program will fit the coefficients (if they

are all equal to 0) to the linear interpolation as a convenient starting point. From there

you can eventually choose one of the two more complex models.

Figure 4.11: Selection of different background models.

4.5.4 Excluded regions

All regions of the powder pattern which cannot be explained by the underlying model(s),

e.g. direct beam, negative intensities, zero sigmas, parasitic peaks etc., should be excluded

from the refinement and from the calculation of agreement factors. In order to do so one

has to activate the excluded region mode by clicking the second icon next to the pattern file

name. Now, exluded regions can be drawn by left-clicking and draggin which will create a

gray box (note that zooming is disabled when excluded region mode is activated). Already

drawn excluded regions can be modified by placing the moue over one of the limits which

will change the mouse cursor into horizontal arrows. The lower/upper limit can now be

dragged. The excluded regions can also be modified in the table on the right. An excluded

region can be deleted by right-clicking it in the pattern plot. Note that depending on the

chosen option in the settings menu the pattern is nevertheless calculated in these regions,

but not included in the calculation of χ2.
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4.5.5 Pattern and phase parameters

In order to allow the correlated refinement of powder patterns and single-crystal data at

different temperatures, the overall temperature factor Bov has a special function. If it is

set to 0 and is not refined, then the temperature factors listed in the Atoms tab will also

be used for this particular powder pattern. If a non-zero value is entered for Bov or if it

is flagged as a refined parameter, only the Bov value will be used in the powder pattern,

while the B values in the Atoms tab are applied to the single-crystal data. Like this it

is also possible to use anisotropic temperature displacement factors for single-crystal data

sets, while using an overall isotropic temperature factor for the powder data at the same

time.

The remaining parameters grouped in the Offsets/Time of flight and Scaling categories

are explained in Secs. 7.7.1 and 7.7.1.6.

More than one phase can contribute to a single pattern and in that case multiple phases

have to be set up in the main window (see Sec. 2.2). The parameters which are grouped

in Cell, Profile, Asymmetry/Rise and decay, Preferred orientation and Absorption and

extinction (only for TOF) concern a specific phase in a specific pattern. The pattern can

be specified - as explained above - by choosing from the combo box in the upper-left part

of the tab. The phase can be chosen in the Phase category. Furthermore, it can be defined

if the phase has a nuclear contribution, a magnetic contribution or both. Having different

sets of parameters for the same phase, which contributes to different patterns, allows for

example the co-refinement of two patterns at two very different temperatures resulting

in different lattice constants. The only part which is common to all patterns (and other

types of data of the same phase) are the parameters listed under the Atoms and Moments

tabs (except for the temperature factors if Bov > 0 in the powder pattern). Therefore,

one has to keep in mind that co-refining different data sets is only meaningful if one can

assume that the fractional atomic parameters do not change too much. Note that the

information given in the Domains tab is ignored for the calculation of powder patterns,

i.e. only a single twin with a single magnetic domain is considered. If different phases

with different cell metrics contribute to the powder pattern, the option Ignore secondary

phases for single crystal needs to be checked in the settings menu, if a co-refinement with

single-crystal data is intended. Otherwise, the contribution of secondary phases will be

considered to the (hkl) reflections of the main phase, which is not correct.

Note that after accepting a fit result (click on the Accept button) the lattice constants and

the propagation vector(s) are not automatically transferred to the model(s) in the main

window as those values are in principle used in the reduction and refinement of single-

crystal data (the cell and q are of course saved in the powder model). One can however

transfer these parameters between the main window and the models for powder patterns
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by right-clicking the label Cell or Propagation vector q (in the Symmetry and Spins tab

of the main window) and choosing the corresponding option and pattern number.

4.5.6 Constraints

If one can safely assume that the same structural model contributes to different patterns,

e.g. a neutron and an x-ray pattern taken at the same temperature or two neutron patterns

taken with different wavelengths, then constraints should be set. In such a case it would

be a good idea to constrain the cell parameters. Or if two phases contribute to the same

pattern and one can exclude peak broadening due to strain, then the profile parameters

could be constrained. Constraints can conveniently be set by right-clicking the respective

category label and then choosing the pattern and phase to which the parameters should

be constrained (in analogy to simple constraints described in Sec. 4.4). The example in

Fig. 4.12 shows how the cell parameters of phase 1 in pattern 2 are constrained to the

cell parameters of phase 1 (i.e. the same phase) in pattern 1. After setting a constraint

the corresponding values are directly synchronized and the fit flags (in this case of phase

1 in pattern 2) are disabled. It is not necessary to constrain the profile and asymmetry

parameters of the magnetic contribution to the nuclear contribution, since all magnetic

parameters are ∆ values, i.e. they are added to their nuclear counterparts. In other words,

if a magnetic ∆ parameter is 0, it is automatically constrained to the nuclear parameter.

Figure 4.12: Example of how the cell parameters of one phase can be constrained to be

the same in two different patterns.

4.6 Refinement and results

Once the data are loaded and the refinement flags and constraints are set, one can proceed

to the Fit tab. Here one can control how the eventual co-refinement should be weighted.

This is visualized by a weight triangle in which a draggable dot marks the different weights

in trilinear coordinates (see Fig. 4.13). The weights of the respective data sets sum to 1

and are shown on the left of the triangle where they can also be set manually. If only one

type of data was loaded, then the dot is fixed in one of the three corners. If two types are

loaded, the user can drag the dot on one of the three lines of the triangle. And when all
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three data types were loaded, the dot can be dragged everywhere within the triangle. For

convieniency the dot snaps to the center of the triangle and to the bisections.

Figure 4.13: The weight triangle is a graphical way to set the respective weights of the

data sets. When 2 (3) different types of data were loaded the dot can be dragged within

a line (within the whole triangle). When only a single data type is present, the dot stays

in the respective corner. The weights can also be set in the respective boxes, which are

synchronized with the triangle.

The least-squares refinement will therefore minimize

χ2 = wSNP · χ2
SNP + wINT · χ2

INT + wPOW · χ2
POW (4.8)

where χ2
SNP , χ

2
INT and χ2

POW are the respective χ2 values of the polarimetry, integrated

intensities and powder data, respectively. Note that the weight given for intensity and

powder data is further split if multiple data sets exist for which the individual weights

can be set in the Data tab. The convergence criterium ϵ can be set in the Settings of the

program and it refers to the maximum relative shift of a parameter in an iteration divided

by its standard deviation. The refinement stops when

∆(p)/σ(p) < ϵ (4.9)

where ∆(p)/σ(p) represents the maximum value in an iteration for parameter p. Also the

maximum number of iterations can be set.

The refinement can be started by clicking the Fit button and the progress as well as the

results are shown in the text field to the left. For every iteration the χ2 value will be

printed together with the maximum relative parameter shift. Either when the maximum

number of iterations has been reached, the convergence criterium is fullfilled or the Stop

button is clicked (the Fit button changes label automatically), the refinement will stop and

list the χ2, reduced χ2 and RF value (the last only applies for the integrated intensities

and powder patterns). The refined parameters with their respective standard deviation

are shown below.

The refinement is visualized on the right-hand side of the window (see Fig. 4.14), where
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4.6 Refinement and results

the integrated intensites are shown in an Iobs-vs-Ical plot (flipping ratios are shown in an

Robs-vs-Rcal plot), powder patterns are represented as usual with the observed, calculated

and difference lines and the polarization matrices are shown for each magnetic Bragg re-

flection. The latter is achieved by showing the observed polarization matrix entries as

circles and the calculated ones as squares. The color code is red for x, green for y and blue

for z, while those colors refer to initial polarization Pi for the marker face color and to the

final polarization Pf for the marker edge color. E.g. a red square with a blue edge refers

to an initial neutron polarization along the local x axis and a analysis direction along

the local z axis, i.e. to the term Pxz of the polarization matrix. In case of multiple data

sets of a single type (intensities or powder patterns) the one to plot can be selected from

the combo box in the upper-right corner of the window (appears only when multiple data

sets are loaded). If you have loaded Numors corresponding to a rotation of the incident

Figure 4.14: Output and visualization of the fit results.

neutron polarization within the y-z plane, the resulting plot contains the curves for each

magnetic Bragg reflection on which this measurement was done (Fig. 4.15). The usual

zoom controls work on this plot and the mouse can be hovered over a data point to obtain

the exact values. A table of the observed and calculated intensities (also derived from

powder patterns) as well as polarization matrices can be seen by clicking on View results,

the same table can also be exported into an ASCII file by clicking on Export results. For

powder patterns, more information is displayed, e.g. the scattering angle, d value, FWHM,

line shift and F 2 values.
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Figure 4.15: Visualization of the fit results when the data correspond to a rotation of the

initial neutron polarization within the y-z plane.
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4.7 Batch fitting

When more than one parameter is refined, the View correlations button is enabled which,

when pressed, opens a window in which the correlation and the covariance matrix is

shown. Note that if correlations exceeding 70% are present the View correlations but-

ton will be given the focus in order to notify the user. Within the correlations window,

the (anti)correlations with more than 70% will be marked. This threshold value can be

modified in order to focus on weaker or stronger correlations. Note that this window can

be kept open for subsequent refinement steps, which will automatically update the values

of the correlation matrix. The button focus will be set according to the actual threshold

value in the correlation matrix window.

If you are satisfied with the refinement (step) you can click the button Accept. This will

pass on the refined parameters to the main window, replot the magnetic structure and

you can afterwards save it to your input file. If the fit diverged or did not improve you

can close the window without clicking Accept, like this the initial parameters before the

respective refinement step are kept in the main window. It is also possible to (repeatedly)

click the Undo button (or Ctrl/Cmd + Z) which reloads the parameters and flags which

were present before clicking the Fit button.

4.7 Batch fitting

Batch fitting is presently only possible for powder patterns. It first requires to refine a

single powder pattern as described in Sec. 4.5 and accept the fit in order to transfer the

refined parameters to the main window. Note that the fit flags and eventual constraints

need to be set in this single refinement and will be used in the batch fit afterwards. It

is also possible to open an xml file to which fit results have been saved previously. If an

initial model is present the action Batch fit will be enabled in the Fit menu of the main

window. When entering the Batch fit window the initial model and its corresponding

pattern will be shown in the upper-right part of the window. The same functionalities are

enabled as for the pattern plot in the Fit window.

A sequence of powder patterns can be loaded in the upper-left part of the window by

clicking on the Load button. The sequence can consist e.g. of powder patterns of a sample

recorded at different temperatures or of different samples with varying composition. For a

meaningful use of the batch fit option the powder patterns should not vary too much from

step to step. The loaded samples will be shown in the item list below the Load button and

clicking the different items will show the different patterns in the pattern plot together

with the initial model. If the loaded patterns contain metadata like temperatures (set

point, regulation, sample) or composition it can be sorted according to that parameter by

clicking on the Sort button. A dialog box will open which contains the possible variables,
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note that sorting according to the file name is always possible. The loaded patterns can

be cleared by clicking on the Clear button.

When a sequence of powder patterns is loaded the refinement can be started by clicking

on Fit batch. By using the option refined values = next start values it is more probable

to have a converging fit from pattern to pattern. Otherwise, the same start parameters of

the initial model will be used for every single pattern in the list. The fit progress is shown

for every pattern by outputting the iterations and χ2 values like for standard refinements.

After each fit the corresponding pattern is shown in the pattern plot. When the last

pattern has been processed the refined parameters are shown in the parameter table in

the center of the window. The current pattern or all patterns at one time (the pattern

number will be added as an extension to the chosen file name) can be exported into pdf

format.

Variables can easily be plotted by ticking either the check box Plot 1 or Plot 2 which refer

to the left or right y-axis of the parameter plot on the lower-right part of the window.

The plot style can be customized by chaning the color, the line style and width as well as

marker type and size. Legend entries and axes labels can be entered in the corresponding

text fields which are synchronized with the parameter plot. The plot can be exported

either as pdf or ASCII.

Figure 4.16: Batch fit window allowing to sequentially refine powder patterns. The refined

parameters can easily be plotted against temperature, composition or pattern number.
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maps

5.1 Reflection lists and intensity maps

Once a crystal and magnetic structure has been set up reflection lists can be generated via

the menu entry Generate→Reflection list or using its toolbar icon or shortcut (Ctrl/Cmd

+ L). A window will pop up in which the criteria like the (hkl) range, nuclear and mag-

netic structure factors, polarization values can be set. If an orientation matrix has been

entered, then the diffractometer angles (calculated according to the instrument definition,

see Sec. 3.9) can be used as a criterium as well. In that case it can be chosen, if only

accessible reflections should be listed. By clicking Create list a table will be created which

can be ordered according to a specific value by right-clicking on the horizontal header en-

try and choosing ascending or descending. The table can be exported in a format directly

readable by MAD or NOMAD (running on ILL diffractometers) by clicking Save. A demo

video can be seen here.

Intensity maps can be generated by triggering Generate→Intensity map, using its toolbar

icon or shortcut (Ctrl/Cmd+ M). All nuclear and magnetic structure factors for integer

and satellite reflections will be calculated (for the current phase in the main window) in

the range from -10 to 10 for h, k and l. The initial view is the (hk0) plane, which can

be altered by choosing the plane from the combo box or the layer in the spin box (see

Fig. 5.1). The boundaries can be set for the horizontal and vertical axes in the second

line. The resolution corresponding to the full width at half maximum of a 2D Gaussian

function can be set individually for the h, k and l directions. The intensity maps’ intensity

color scale will automatically be rescaled to the minimum and maximum intensity of the

actual map. In order to compare intensities between different maps or layers, the check

box Rescale can be unchecked, which will therefore conserve the scale. Furthermore, a

logarithmic scale can be chosen or nuclear scattering can be hidden. The maximum and

minimum values of the intensity scale can be modified by the vertical sliders to the right

of the map. This can be useful to emphasize weak reflections.

In case of multi-q magnetic structures scattering from differently modulated components
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of the magnetic structures can be added. For that the magnetic structure in the main

window should be modified (especially the propagation vector) and regenerated. Alter-

natively, a second phase can be added in the main window and set as the current one.

Afterwards, the scattering from that new magnetic structure can be added to the intensity

map by clicking Add. The x, y and intensity values are visualized by hovering the mouse

over the map. Zooming in and out are achieved with the usual mouse controls. Intensity

maps can be saved as pdf or ASCII files by clicking the corresponding button at the bot-

tom. By holding down the Ctrl/Cmd key while drawing a rectangle a projection will

automatically be calculated and plotted in a new window (see Fig. 5.2). The projection is

always along the shorter side of the rectangle. Zooming and point labels are enabled and

the projection can be saved as pdf and ASCII as well.

It is also possible to view maps in 3D (see lower panel of Fig. 5.1). This feature is par-

ticularly interesting for non-orthogonal systems in order to appreciate the real crystal

symmetry. By clicking on the buttong View 3D a new window will open, showing the

map with the same boundaries and color code in three dimensions. The intensity scale

(peak amplitude) and appearance of axis and labels can be adjusted before creating a

high-quality picture.

5.2 Powder pattern

Mag2Pol features the quick simulation of powder patterns which can be done via the

menu entry Generate→Powder pattern or the toolbar icon (see also this demo video). A

new window will open showing the global pattern, i.e. the sum of all phases (see Fig. 5.3).

In the lower left corner of the window the geometry of the instrument can be changed,

i.e. the source (neutron or X-ray), the wavelength and the resolution function via the uvw

parameters of the Caglioti formula:

FWHM2 = u tan2 θ + v tan θ + w

The powder diffractometers of the ILL (D1B, D2B, D20) can be chosen with different

configurations from the combo boxes which will set the respective parameters automati-

cally. When xray is chosen as source, then a right-click context menu is enabled for the

wavelength value from which different standard x-ray wavelengths can be chosen, which

will automatically use the α1 and the α2 line.

The plot of the powder pattern can be zoomed in with the usual rectangle zoom and

zoomed out with a right click. Hovering over the peak markers below the pattern will

show a tool tip containing the scattering angle and the corresponding (hkl) reflections.

In the lower right corner the user can change the appearance of the powder pattern (colours

56

https://www.ill.eu/fileadmin/user_upload/ILL/3_Users/Instruments/Instruments_list/00_-_DIFFRACTION/D3/Mag2Pol/Videos/Powder_pattern.mp4


5.2 Powder pattern

Figure 5.1: Intensity map in the (hk1) plane.
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Figure 5.2: Projection along k of the scattered intensity along the (h20) line of the map

shown in Fig. 5.1.
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5.3 Magnetization density maps

Figure 5.3: Powder pattern showing the nuclear and magnetic contribution separately.

and line styles) and choose whether nuclear and/or magnetic patterns should be shown

individually. An additional broadening of the peaks can be introduced through the ∆w

value for the nuclear and magnetic patterns separately. The individual patterns can be

exported into a text file or the visualized pattern(s) can be exported as a PDF file.

5.3 Magnetization density maps

Magnetization density maps (see an example in Fig. 5.4) can be created by calculating a

Fourier inversion according to:

ρ(r) =
1

V

∑
hkl

M exp[2πi(hx+ ky + lz)]

where the Fourier coefficients are the magnetic structure factors M . Projections, like e.g.

onto the x-y plane are obtained by

ρ(r) =
1

bc

∑
hkl

M exp[2πi(hx+ ky)]

Note that the theoretical magnetic structure factor of the experimentally inaccessible (000)

reflection is added for scaling purposes in both calculated and observed maps. Different
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5 Reflection lists, powder patterns and maps

Figure 5.4: Slice of 0.2 Å thickness around x = 0.15 in the y-z plane in 2D (upper panel)

and 3D (lower panel). The Fourier inversion is taken up to the highest measurable Qc

with the given wavelength.
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Fourier maps can be chosen from the combo box, e.g. calculated maps with different

cut-off angles corresponding to a critical Qc, observed maps from *.int or *.fli flipping

ratio input files or difference maps. Furthermore, the user can choose from projections,

cuts or slices within the x − y, x − z or y − z plane. The different layers, or the vertical

parameter, can be changed using the arrow buttons. A right-click on the layer value will

pop up a context menu from which either the single step value can be set to the actual

shown value or the whole range of layers from 0 to 1 can be calculated at once. For all

calculations the program will make use of the nuclear symmetry in order to speed up

the process. Note that each map is only calculated once, i.e. repeated scrolling through

already calculated maps will not cost calculation time. However, when the bin value is

changed, all previously calculated maps will be deleted. It has to be noted that the maps

will sometimes show unusual details coming from binning artefacts. Therefore, the default

bin has been set to 0.1 Å and the lattice constants are rounded, which usually gives good

results for the Fourier maps.

The magnetization density maps can also be viewed in 3D (see Fig. 5.4). This feature

is particularly interesting for non-orthogonal systems in order to visualize the correct

symmetry (see also this demo video).
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6.1 Sample information

Once a nuclear and/or magnetic structure model has been entered it is possible to see

a summary of the main parameters via the menu entry Tools→Sample info or the tool-

bar icon. Under the Crystal structure tab (see Fig. 6.1) the real and reciprocal lattice

paramters and volumes are shown together with a list of all the atoms in the unit cell.

A list with magnetic moments and Fourier coefficients can be found under the Magnetic

structure tab. All information related to the absorption correction are shown under Ab-

sorption. Note that the interactive tool to create the sample model (Sec. 4.2.2) can directly

be accessed from here. The last refinement results can be viewed unter the Fit tab.

Figure 6.1: Summary of basic parameters entered by the user.
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6.2 Space group tables

The space group tables and conversion tools for crystallographic (CSG), magnetic (MSG)

and magnetic superspace groups (MSSG) can be consulted under Tools→Space group ta-

bles or via its corresponding toolbar icon. When entering the window without a previously

defined structure model, the symmetry operators and Wyckoff positions as well as basis

vectors for MSGs can be viewed for any space group with or without basis transformation.

Selecting a space group to set up a structure model including the transformation of the

unit cell and atomic positions is only possible with a previously defined structure model.

The Space group tables window is organized in four tabs, from which the first three are:

CSGs, MSGs and MSSGs (see Fig. 6.2). Space groups can be entered via their (numerical)

labels, e.g. I4/mmm or 139, Pm′n′a or 53.326, P2.1′(0, 0, g)0s or 3.1.5.3.m2.2, or they

can be chosen from the combo boxes where they can also be sorted by system for easier

navigation. As stated in Sec. 2.2, all information concerning MSGs and MSSGs is based on

the computer-readable tables available on the Isotropy Software Suite website [1–3]

and the work published in [4–6]. For further information, the reader may refer to the

excellent reviews [24, 25]. If a space group has been correctly entered its label will be

shown in green (red if not) and the crystallographic information will be shown in the text

window below. This information consists of the operators of the space group (including

time inversion operator for MSGs and the internal variable for MSSGs) followed by the

Wyckoff positions in case the space group has been entered in its standard setting (a few

non-standard CSGs are implemented in Mag2Pol). The basis of any space group can be

transformed to another setting which can be useful to compare a structure with another

one published in a different setting, and is necessary for a reasonable use of MSGs and

MSSGs. The transformation operator can be entered either by writing a string in standard

notation which will display the rotational part R and translational part t of the operator,

or vice versa, by entering R and t which will display the transformation string. The cor-

rect syntax will be shown in green and requires the transformation string to be enclosed

in parantheses, the rotational and translational part to be separated by a semicolon and

the individual axes to be separated by a comma. The identity would be expressed as (a,

b, c; 0, 0, 0), where the spaces are optional. A swapping of the a and b axes with an

origin shift along c would correspond to (b, -a, c; 0, 0, 1/2). Note the minus sign to

conserve a right-handed set of axes and the possibility of entering fractions. The correct

application of basis transformations, especially when entering information obtained from

other tools (e.g. Bilbao Crystallographic Server or Isotropy), will be shown in

the next sections.
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6.2 Space group tables

The fourth tab Preview serves to visualize the crystal and magnetic structure in the

main window and allows to modify the degrees of freedom, i.e. atomic positions and basis

vectors of magnetic moments respecting the underlying symmetry. If bonds and polyhedra

were drawn beforehand, the program will show their deformation in real time.

Figure 6.2: Left: Space group tables for crystallographic, magnetic and magnetic super-

space groups containing information about symmetry operators, Wyckoff positions and

basis vectors. Furthermore, any transformation can be applied to any of the space groups.

Right: Preview window allowing to transfer a space group to the main window, to modify

the degrees of freedom and to visualize the crystal and magnetic structure.

6.2.1 Space group transformations

After choosing a space group from the combo boxes or by entering its (numerical) label,

Mag2Pol will always load the untransformed operators and Wyckoff sites regardless of

the given transformation operator. The basis transformation is only applied when clicking

on Transform SG, which will update the crystallographic information in the text box

above, which is also shown by the basis transformation string next to the space group

label.

If the user wishes to transfer the space group to the structure model initiated in the main

window, this can be achieved by clicking Transfer SG in the Preview tab. Several options

exist which depend on what the user wishes to achieve. If the checkbox convert lattice

constants is activated, the rotational part of the transformation operator is applied to the

lattice which will be updated in the main window. The same applies to convert atomic

positions which - if activated - will convert the position vectors by taking into account
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the rotational and translational part. The last checkbox split sites in subgroup should

be activated, when a group was chosen in the Space group tables which is a subgroup of

that in the main window. In this case, the program will identify the symmetry operators

missing in the subgroup and create new atoms in the structure model, if sites split into

different orbits. Two examples will clarify the use of these checkboxes:

• Convert a structure expressed in Pnma to Pnam

Enter the Space group tables with a Pnma structure model in the main window.

The transformation to Pnam is expressed by (a, c, -b; 0, 0, 0) or equivalently

by (a, -c, b; 0, 0, 0) which should be entered in the corresponding field under

the Crystallographic SGs tab. Alternatively, the rotation matrix can be entered,

which will create the transformation string as a confirmation. Click Transform SG

to apply the transformation and check the results in the text box above.

Now switch to the Preview tab. Due to the swap of b and c axes the lattice pa-

rameters and the atomic positions previously defined in the main window should be

updated in order to conserve the structure. Therefore, convert lattice parameters

and convert atomic positions should be activated. On the other hand, all symmetry

operators of Pnam will be different from the ones in Pnam, but the site multiplicity

remains unchanged. Therefore, the split sites in subgroup checkbox should not be

activated. Now click Transfer SG and inspect the structure in the main window.

You can move the sliders or enter values for free positional parameters to verify the

structural degrees of freedom and you can go back to the initial values by clicking

Reset parameters. If the transformation does not show the expected results, it can be

reverted by clicking Reset symmetry which will take the structure back to its state

before entering the Space group tables window. If the Space group tables window was

closed after transferring the space group and converting the structural data, it is still

possible to recover the original structure by right-clicking the Space group label in

the main window and choosing the appropriate action from the reset transformation

menu. Any of the options will set the transformation operator to identity, i.e. the

symmetry operators of the original space group will be used to generate the cell.

The optional conversion of the lattice parameters and the atomic positions will be

done with the inverse of the former transformation operator. In this example, the

correct option would therefore be convert both.

• Convert a structure expressed in Pnma to its non-isomorphic subgroup P21ma

From the International Tables Vol. A [8] one can obtain the following information

concerning the non-isomorphic subgroup: P21ma (Pmc21, 26) 1; 4; 6 ;7. The sub-

group P21ma is a non-standard setting of space group 26, Pmc21, and the symmetry

operators 1, 4, 6 and 7 of Pnma are conserved. Since Mag2Pol lists the opera-
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tors in the exact same order, it is straightforward to compare the respective space

groups. First, set up the structure in Pnma symmetry in the main window and

then enter the Space group tables window (copy the symmetry operators for a more

comfortable comparison afterwards). Choose space group Pmc21 under the Crystal-

lographic SGs tab, which now has to be converted to P21ma. The rotational part

of the transformation is easy to extract by comparing the two space group labels.

Therefore, in a first step the transformation (c, a, b; 0, 0, 0) can be entered

followed by a click on Transform SG. Now, paste the Pnma symmetry operators

below the converted ones and compare operators 1, 4, 6 and 7. It is apparent that

a rotation of the basis is not sufficient and that a shift of origin is necessary. It can

be verified that the correct transformation is (c, a, b; 1/4, 1/4, 0). Enter the

string and click Transform SG (note that for each transformation the original space

group is reloaded before applying the transformation, i.e. one cannot do a chain

of transformations), which should produce the four symmetry operators of Pnma

numbered 1, 4, 6 and 7. The transfer of the new symmetry to the main window

is effectuated in the Preview tab. In this case, the axes and atomic positions have

been transformed to match those of the original structure in Pnma, so the first two

checkboxes should not be activated. On the other hand, since the general multiplic-

ity of P21ma is 4, while it is 8 in Pnma not all atomic positions will be generated

in the subgroup, for which the split sites in subgroup option needs to be activated.

Finally, click on Transfer SG and verify the result.

The conversion from the non-standard setting P21ma to Pmc21, if intended, can be

done by closing the Space group tables window and by resetting the transformation

via the Space group label context menu as explained in the previous point.

6.2.2 Magnetic space group transformations

The basic use of magnetic space groups and their transformations is very similar to the

explanations in the previous section with a few exceptions. The first is related to the

fact that the transformation operators are always applied to the parent space group which

is the definition used by the programs of the Bilbao Crystallographic Server for

example. Therefore, the chosen magnetic space group is transformed with the inverse of

the shown transformation, since the direct transformation is applied to the parent space

group which is (related to) the paramagnetic space group. The second difference concerns

the transformation of lattice constants and atomic positions which are always calculated

according to the transformation operator under the Crystallgraphic SGs tab. This makes

it possible to effectuate complex transformations of both the CSG and the MSG to obtain

the desired result. A good starting point for finding appropriate MSGs is the use of the
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MAXMAGN program [25] on the Bilbao Crystallographic Server. After entering

the crystallographic space group and the commensurate propagation vector one obtains

a list of maximal magnetic space groups. By clicking the Show button in the General

positions column one can obtain both the augmented transformation matrix for the CSG

and for the MSG. How to correctly enter this information will be shown in the following

example from [25].

• Magnetic space group Paca21 as a child of the parent space group Pbam

The use of MAXMAGN with space group Pbam and propagation vector q = (1/2 0 0)

reveals four maximal magnetic space groups, one of them being Paca21 (#29.104),

but in a special setting. First of all, set up the paramagnetic Pbam structure in the

main window and enter the Space group tables window. Here, enter the basis trans-

formation of the parent space group which is given as (2a, b, c; 0, 0, 0) on the

General positions page of the MAXMAGN output. Click Transform SG which will

result in doubling the symmetry operators of space group Pbam due to the addi-

tional translation t(1/2 0 0). Now switch to the Magnetic SGs tab and enter either

P aca2 1 or 29.104 which will show the symmetry operators, Wyckoff positions and

basis vectors for that magnetic space group. Enter the transformation of the MSG,

this time given in matrix form in the MAXMAGN output, which becomes (a, -c,

b; 1/8, 0, 0), and click Transform MSG. At this point it is important to compare

the symmetry operators in both tabs. If the transformations were applied correctly,

the MSG should be a subgroup of the SG and reveal a subset of the symmetry op-

erations (primed or unprimed) of the latter. In this example the 8 MSG operators

can be found in the CSG (operators 1, 3, 6, 8, 9, 11, 14 and 16). Now the MSG

can be transferred from within the Preview tab. Since the CSG was adapted to the

doubling along the a axis, the lattice parameters and the atomic positions need to be

changed accordingly, i.e. the convert lattice constants and convert atomic positions

checkboxes need to be activated. Furthermore, since the MSG only reveals a subset

of the symmetry operators in the CSG, not all the atomic positions can be generated,

for which the split sites in subgroup checkbox needs to be activated as well. Now,

click Transfer MSG, inspect the resulting structure in the main window by adjusting

the degrees of freedom under the Crystal structure and Magnetic structure tabs and

accept the result by closing the Space group tables window. As described above, the

transformation of the MSG can be converted back to the original Paca21 setting by

evoking the context menu on the Space group label in the main window.
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6.2.3 Magnetic superspace group transformations

The use of MSSGs is almost the same as for MSGs with the exception that no transfor-

mation of the parent paramagnetic space group is necessary. When selecting a MSSG

symmetry (either by typing its label or by choosing it from the list) and transferring it

to the main window in the same way as described for MSGs, Mag2Pol automatically

calculates the basis vectors for all the magnetic ions in the structure model. Depending

on their point symmetry certain components may be extinct or relations between real and

imaginary components might exist. Note that the order of basis vectors is not necessarily

the same as shown in the Isoviz plotting tool and that split sites are treated as indepen-

dent sites in Mag2Pol. The interested reader may consult [24] for a complete overview

on MSSGs.

A good starting point to identify possible MSSGs for the underlying crystal structure and

incommensurate propagation vector is the use of the Isotropy Software Suite web-

site [1–3]. A *.cif file can be exported from Mag2Pol and loaded on the website to

start a new distortion (choose only magnetic). Enter the propagation vector using Method

2: General method - search over specific k points, enter the necessary propagation vector

coefficients, set the number of incommensurate modulations to 1 [note that only (3+1)d

modulations can be treated with the present version of Mag2Pol] and click OK. On the

next page all necessary input parameters can be found for the different possible modes.

Either extract the information from this page or select a mode and click OK. On the next

page it is possible to download an *.isoviz or *.cif file, from which the latter can be

directly loaded in Mag2Pol after changing its extension to *.mcif. The *.mcif files

downloaded from the Isotropy Software Suite contain the original setting and the

one adapted to a standard paramagnetic space group. On loading the file, it can be chosen

which setting to employ. Note that for MSSGs with origin translations t such that the dot

product with the propagation vector q is non-zero, the visualization in the conventional

cell might look different than that of the untransformed MSSG. The correct use of the

MSSG transformation is shown in the following example.

• Magnetic superspace group P21/b.1
′(0, 0, g)00s as a child of the parent space group

P21/c with propagation vector q = (0 0.32 0)

First, set up a structure in P21/c symmetry and export is to a *.cif file which can be

uploaded on the Isotropy Software Suite website. Enter the propagation vector

underMethod 2 by choosing LD, k3 (0, b, 0) and enter b = 0.32, set the number of in-

commensurate modulations to 1 and click OK. On the next page, select the first mode

corresponding to the MSSG P21/b.1
′(0, 0, g)00s. From here the necessary input can

already be transferred to Mag2Pol by entering the given basis transformation. In

this example the output basis={(1,0,0,0),(0,0,1,0),(0,-1,0,0),(0,0,0,1)},
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origin=(0,0,0,0) needs to be entered as

R =


1 0 0 0

0 0 −1 0

0 1 0 0

0 0 0 1

 t =


0

0

0

0

 (6.1)

followed by a click on Transform MSSG. At this point, it should be verified that

the transformed operators constitute a subset of the ones in the parent space group

P21/c. As this is the case one can transfer the MSSG from the Preview tab. The

parent space group is left unchanged for which no conversion of lattice constants

and atomic positions is necessary. Furthermore, the general site multiplicity is the

same in both MSSG and CSG. Therefore, all the options should be unchecked before

clicking Transfer MSSG.

6.3 Data converter

Data from ILL Triple Axes Spectrometers (TAS) can be opened with Mag2Pol and

converted to a *.fli file under certain conditions:

• each Numor contains a 1-point (peak) or 3-point scan (left background - peak - right

background)

• the scan was done using a PAL file which defines the polarization channels to measure

• the information concerning Pi and Pf are listed as output parameters for each point

of the scan

If these criteria are not met, the program will show an error message for each corresponding

Numor which could not be (fully) loaded (see Fig. 6.3).

6.4 Irreducible representations

Mag2Pol offers the possibility to calculate the irreducible representations (irreps) which

yield magnetic structure models with different symmetries that are allowed by the under-

lying crystal structure and the propagation vector (see this demo video). The method of

obtaining the irreps is based on the induction method which is very well explained in [26].

In fact, in order to obtain the irreps of space group G(k) one has to find the irreps of its

invariant subgroup G′(k) of index 2 or 3. This co-set decomposition is done iteratively

until the translation group or a cyclic group is reached, whose irreducible representations

can readily be written down. The case of cubic space groups is dealt with separately in
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Figure 6.3: List of loaded polarization data. Incomplete information will be output with

a warning message.

the original paper and has been adopted as well in Mag2Pol.

The menu item Generate→Irreducible representations and the toolbar icon will be enabled

after generating a structure with at least one magnetic site. Note that depending on the

remaining magnetic symmetry operators certain magnetic sites split into several orbits.

This will automatically be updated by the program in the main window (note that split

sites should be grouped together in the atom list, when a structure model is entered man-

ually, i.e. without using the irrep tool). Similarly, if the given structure already contains

split sites (either because the user entered them or because the irreps calculation has al-

ready been run at least once), they will not be split again. I.e. the irreps calculation can

be performed several times without the need of modifying the sites in the main window.

Triggering Generate→Irreducible representations will open a new window in which a sum-

mary of the symmetry information will be shown in the Symmetry tab (see Fig. 6.4).

The symmetry operators are shown exactly as in the International Tables for Crystallog-

raphy Vol.A including the same order. Further below, the symmetry operators of the little

group are shown, i.e. those symmetry operators which are compatible with the magnetic

translation symmetry. Then a list containing the magnetic atom positions is shown in-

cluding the information if a split orbit is present and which symmetry operator (lost in
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Figure 6.4: Irreducible representations window showing the symmetry operators, the

atomic positions and a summary of the calculation.

the transition) relates the orbits. Under the tab Multiplication table (see the left panel

of Fig. 6.5) one can see how the symmetry operators act under the group multiplication.

The note below the table changes depending on the active cell and adds the information

if a phase shift needs to be applied, when a non-zero propagation vector is present.

The tab Irreps contains the table of the irreducible representations (see central panel of

Fig. 6.5). Eventual exponential factors are abbreviated and explained in the legend below

the table. A right-click on the vertical header item, e.g. Γ1, pops up a menu in which this

particular irrep can be transferred to the current phase in the main window. By high-

lighting two irreps and right-clicking either one a mixed irrep can be set. If no particular

basis vectors are selected in the tab Basis vectors all basis vectors are transferred to the

current magnetic structure in the main window. Note that a maximum of 6 basis vectors

can be used per site, for which an error message will pop up, if this number is exceeded. In

that case, or also if certain basis vectors can be excluded, the basis vectors to export can

be highlighted in the Basis vectors tab (see right panel of Fig. 6.5) for the corresponding

irrep(s). The basis vectors can be visualized in different ways: basis vector of the first

atom of each site normalized to 1, normalized with abbreviated exponential factors or

with the smallest component normalized to 1. Note that the basis vector will always be

exported with the basis vector of the first atom normalized to 1 so that the multiplying

coefficients can be interpreted as Bohr magnetons. Each basis vector can (repeatedly) be

multiplied by i, e.g. to combine two irreps in phase quadrature.

By setting the coefficients, which are multiplied to the basis vector, in the main window
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Figure 6.5: Irreducible representations window showing the multiplication table, the irre-

ducible representations and the basis vectors.

(under the Magnetic structure tab) to a non-zero value, the magnetic structures can be

visualized instantly and compared to each other. The irreps information will be saved in

the input file, so that the calculation does not need to be repeated. Hovering over the

coefficients in the main window will show tool tips explaining to which irrep and basis

vector the coefficients belong. Note that when the magnetic structure results from an

irrep calculation it is not necessary to explicitly enter the magnetic symmetry operators

by hand. They are internally stored together with the corresponding magnetic phases.

One can also look up the basis vectors in Structure→Basis vectors and change the way

of setting up the magnetic strucure, i.e. use symmetry-adapted basis vectors from the

irreps calculation, use user-defined basis vectors or use no basis vectors at all (i.e. use uvw

coefficients).

6.5 Spin correlations

Mag2Pol offers a spin-correlation tool which calculates the spin-correlation function

⟨S(R)⟩, the intensity as a function of Q and the magnetic pair distribution function

(mPDF). To calculate those distributions it is only necessary to enter a magnetic structure

in the main window and click on Tools→Spin correlations or the corresponding toolbar

icon. A new window will open and the 3 distribution functions will be calculated based

on the Rmin and Rmax values which can be set to the right of the ⟨S(R)⟩ plot. For the

I(Q) and mPDF plots start and end values as well as a step width can be chosen. For

the latter the resolution can be taken into account via a FWHM value. The underlying

formalism is explained in Sec. 7.6.

The structure plot offers the same functionalities as the main window, i.e. one can click

on the atoms and spins to retrieve information concerning the position, spin components,
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distances and angles. In the spin-correlations window the 3D plot is interactively linked

with the 2D plots of the respective distribution functions. Shift-clicking two atoms to

evoke their distance will automatically show the corresponding distance in the ⟨S(R)⟩
and mPDF plots. It also works the other way round: clicking on a bar in the ⟨S(R)⟩
bar plot will draw the bond between all spins separated by this particular distance. This

offers an intuitive way to understand the correlation functions. All distribution functions

can be exported either as PDF or ASCII via the File→Export menu.

The spin-correlation tool furthermore offers the possibility to visualize the results of reverse

Monte-Carlo simulations performed with the Spinvert program [27]. This can be done

by opening a * spins xx.txt file containing the spin configuration within the supercell.

Note that the atomic positions in Spinvert andMag2Pol should roughly agree (precision

of 0.01) in order to identify the correct positions for plotting the structure. The Rmax

value will be set automatically depending on the used supercell. Eventually there is a

huge number of spins in the supercell, therefore, in order to increase rendering speed and

fluidity the object resolution can be reduced. The visualized supercell can also be adapted

using the box boundary values.

Figure 6.6: Spin-correlation window showing the magnetic structure and the different

distribution functions. The 2D and 3D plots are interactively linked to each other so as

to identify correlations at a particular distance.
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6.6 Multi-q magnetic structures

Multi-q magnetic structures, e.g. conical or fan-like structures, are not only beautiful

but also tricky to visualize. With Mag2Pol this is very easy to do. One only needs

to set up two phases in the main window (see Sec. 2.2) which have exactly the same

crystal structure (note that different space groups may be used as long as the atomic

positions coincide), but different magnetic parameters. In the example shown in Fig. 6.7

a ferromagnetic (q=0) component along the c axis has been used together with a helical

component in the a-b plane modulated by the propagation vector q=(0 0 1/7). In order

to visualize the resulting multi-q structure one has to click on Tools→Multi-q structure or

the corresponding toolbar icon, which will open a new window. Note that for the moment

only two different q vectors can be combined. Furthermore, the case might occur where

the different components have been set up with a different number of magnetic domains.

If the domain number to plot is superior than the number of domains in that phase, then

the first domain is chosen by default.

Figure 6.7: Multi-q window showing the superposition of two magnetic structure com-

ponents, one being ferromagnetic along the c axis and the other one being a helically

modulated component in the a-b plane. The resulting superposition is a conical magnetic

structure. The modulated in-plane component can be emphasized by an ellipse, where

the spin direction is marked by a thin cylinder (left panel) or by a cone tracing the spin

rotation (right panel).
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6.7 LATEX export

The presentation of nuclear and magnetic structure parameters as well as information

about the magnetic symmetry are the central part of a scientific report or publication.

With Mag2Pol it is possible to create tables in LATEX format containing

• nuclear structure parameters (including standard deviations from the last accepted

and saved refinement)

• magnetic structure parameters (including standard deviations from the last accepted

and saved refinement)

• the multiplication table of the given space group or little group

• the table of irreducible representations

• the table of basis vectors for a given irreducible representation and atomic site

These tables can be copied to the clipboard by clicking on Tools→LaTeX export and pasted

into an open *.tex document.

6.8 Pattern editor

The pattern editor is a tool which offers the following features

• plot patterns in 1D, 2D and 3D and export as *.pdf

• add offsets on the 2θ and counts axes of loaded patterns

• create new patterns by building sums and differences

• export patterns in the Mag2Pol format

Patterns can be loaded by clicking the Load button and then selecting the corresponding

format from the input dialog window. If the wrong format was chosen, an error message

will be shown, otherwise the patterns will be shown as a 1D-plot in the panel on the

left part of the window. The patterns and the corresponding properties are shown in the

table on the right. It contains the file name, wavelength, temperature, offsets and plot

styles. The table can be sorted according to file name, wavelength or temperature by

right-clicking the respective column header and choosing either ascending or descending

from the Sort menu. The listed temperature can be switched between sample, regulation

and setpoint by right-clicking the temperature header and selecting from the list within

the Temperature menu.
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As in all other plots zooming is done by clicking and dragging, while a right-click re-

establishes the boundaries which are specified above the plot. If these are changed by the

user they can be reset to the optimal values by right-clicking any of these values and then

clicking reset boundaries. The 3 symbols to the right of the plot boundaries toggle the

legend, error bars and plot grid, respectively. Hovering the mouse over the data points

shows the 2θ values and counts when no more than 5 patterns are plotted.

The appearance of each data set can be modified with the respective line and marker

options and the checkbox Show allows to show or hide a particular pattern. A right-

click on the Show header allows to select between Show all, Show every nth and Hide all.

Choosing the second option will open an input dialog in which the value n can be entered.

In 1D-plotting mode or in order to manipulate and export patterns, offset values can be

added to the 2θ or counts axes. There is a convenient way to apply a gradual offset and

even a gradual color change to all visible patterns: Select the offset/color of the first and

last visible pattern in the table and then right-click on the respective column header and

select Set gradient. Choosing Set as first obviously sets the respective property to the one

for the first pattern in the list. The legend entries can be either typed in manually or set

to the temperature (the one selected in the table) or to the file name by right-clicking the

Legend header and selecting the corresponding option.

When at least 2 patterns are visible the View 2D button is enabled which - after activating

it - shows all visible 1D patterns in a 2D plot where the vertical axes corresponds to the

temperature and the intensity is represented in a color code. Zoom and plot boundaries

work as in 1D mode, additionally, the minimum and maximum values of the color bar

can adjusted by the vertical sliders on the right side of the plot. Note that any offset

values in 2θ and counts are only considered in 1D plots. Clicking the button Export plot

will save the shown plot (1D or 2D) in *.pdf format. As for other 2D maps holding

down the Ctrl/Cmd button and zooming will calculate the projection of the data along

the shorter side of the rectangle and the result will be shown in a new window. After

a 2D map has been plotted it can also be shown in 3D by clicking on the enabled but-

ton View 3D which opens a OpenGL plot. Like for intensity and magnetization density

maps the plot appearance can be adjusted and the plot can be exported in high resolution.

The loaded list can be cleared or exported in Mag2Pol format with *.m2p extension by

clicking on the Clear or Save all button, respectively. Individual patterns can be exported

or removed by right-clicking the vertical header number. The file name shown in the table

will be used to save the file, however, the program will remove any other extension and

replace it with *.m2p, therefore, no original data can be overwritten. New patterns can
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be created from the loaded ones, e.g. sums or differences, by typing an equation in the

field below the table. Each pattern is represented by the letter p and by its corresponding

number in the table. Each pattern, e.g. p3, needs to be preceded by a multiplying

factor, e.g. 2*p3 and the different patterns are combined by either the + or − sign, e.g.

2*p3-1*p4. The correct syntax is visualized by a green font, while a red font means that

there is an error in the equation. When the font is green, the Create button becomes

active and clicking it creates a new pattern which is added to the table and plotted. At

the same time the standard deviations are calculated according to the error propagation

rule.

6.9 Guides to the eye

Certain nuclear and magnetic structures benefit from guides to the eye which highlight

their peculiarities. With Mag2Pol such hints can be added to the OpenGL unit cell plot

in 3D through the following objects (with their corresponding customizable properties):

• Arrow (position, direction, shaft radius, cone radius, cone length, color)

• Cylinder (start position, end position, radius, start color, end color, transparency,

gradient)

• Sphere (position, radius, color)

• Ellipse (position, first axis, second axis, color, transparency)

• Torus (position, first axis, second axis, radius, color)

• Spiral (position, first axis, second axis, radius, height, windings, phase, start color,

end color)

• Sine (position, propagation direction, amplitude, radius, cycles, phase, start color,

end color)

• Plane (at least 3 points, color, transparency)

• hkl plane (hkl indices, color, transparency, family)

• Box (position, length, width, height, color, transparency)

• Text (position, text, font size, color)

All positions are given in fractional coordinates with respect to the unit cell (just like

atomic positions), while all vector quantities are defined in units along the crystallographic
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Figure 6.8: Upper panel: Pattern editor showing diffraction patterns in 1D mode. Center

panel: When at least 2 diffraction patterns are set to be shown, a 2D thermodiffractogram

can be shown by clicking on the View 2D button. Bottom panel: After viewing the plot

in 2D the View 3D button can be clicked which opens a 3-dimensional OpenGL plot of

the thermodiffractogram. 79
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axes, i.e. in the same way as magnetic moments (the length corresponds to the that of

magnetic moments with a plot scale of 1.0). Note that the vectors are not normalized,

i.e. the size of an ellipse or the wavelength of a sine (through the propagation direction)

depend on the length of the vectors. The best way to invert the handedness of a spiral is

to define negative number of windings (it is also possible to define a negative height, but

the spiral will propagate in the opposite direction). Depending on the object it is possible

to define the transparency or a color gradient.

The Guides to the eye window can be accessed via the Tools menu or directly via its

toolbar icon. It shows a list of all guides to the eye presently defined in the unit cell plot.

From here it is possible to create a new guide to the eye (New button), modify a present

one (Edit button), duplicate (Duplicate button) or delete it (Delete button). A click on

the New button opens a dialog from which one of the listed objects can be chosen. This

opens another window in which the respective properties can be entered (see Fig. 6.9).

The visibility of guides to the eye can be triggered in the settings window under the Plot

Figure 6.9: Guides to the eye window (left) showing a list of objects which are depicted

in the unit cell plot. New guides to the eye can be created, edited or deleted. A click on

the New button opens a dialog from which one of the implemented objects can be chosen.

Afterwards, the object can be customized in the object property window (right).

tab. The figures below show some examples in which 3-dimensional guides to the eyes

may be useful (and one example where they are absolutely useless).
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Figure 6.10: Examples of 3-dimensional guide-to-the-eye objects.
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6.10 Phase transitions

In single-crystal diffraction experiments, nuclear and/or magnetic phase transitions are

best identified and illustrated by following e.g. the integrated intensity of selected Bragg

reflections as a function of temperature, magnetic field or pressure. Mag2Pol offers a

Phase transition tool which helps to find appropriate (hkl) reflections showing a significant

difference between the involved structures, or - the other way round - to check if certain

structures explain an observed transition. In order to use this tool it is necessary to define

at least 2 phases in the main window, which are listed in the upper left part of the Phase

transitions window. Each phase is given an x value according to its number, which can be

changed in order to be taken into account in the plot on the right part of the window. In

the lower left part, a list of Bragg reflections reflections can be created by entering the h,

k, l and ±q values and clicking the Add button. The quantities according to the combo

boxes y axis1 and y axis 2 will be calculated and plotted against the different phases.

The plot can be modified with respect to the marker and line styles (note that a different

style is automatically applied for the right y axis, if enabled). User-defined axes, tick and

legend labels can be entered to customize the plot, which can be exported as a pdf or

ASCII file. Reflections can be removed by right-clicking the vertical header labels and

then clicking Remove reflection.

Figure 6.11: Phase transitions window.
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7.1 Basic equations

Mag2Pol uses the plane wave function following conventions of quantum mechanics,

which is generally used for neutron scattering and which is the complex conjugate of that

used in x-ray scattering:

ψQM = ψ∗
XR = ei(kr−ωt)

which requires

b = b′ − ib′′ with b′′ > 0

for the scattering length and yields the scattered wave as a superposition of the plane

wave and the spherical wave in the form of

ψ(r) = eikr + f(θ, ϕ)
eikr

r
.

The scattering amplitude is the Fourier transform of the scattering potential and is given

by

f(θ, ϕ) ∝ −
∫
V (r)e−iQrdr

with the scattering vector Q = kf − ki. Note that using the conventions for X-ray

scattering or Q = ki−kf leads to the complex conugate of the scattering amplitude. The

nuclear structure factor can therefore be written as

N(Q) =
∑
j

ojbje
−2πi(hxj+kyj+lzj)e−Bj sin

2 θ/λ2

with the second exponential term being the Debye Waller factor. The sum is done over

all the atoms in the unit cell and oj denotes the multiplicity and occupation of atom j.

Note that the leading minus sign has been dropped as the square of the structure factor

is used in all calculations.

The magnetic structure factor writes as

M(Q) =
∑
j

pnojSjfj(Q)e−2πi(hxj+kyj+lzj)e−Bj sin
2 θ/λ2

where pn = 0.2695420113693928312 is the conversion factor between Bohr magnetons and

scattering lengths. A factor 0.5 is applied, when the non-zero propagation vector +q is
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inequivalent to −q. Sj are the Fourier coefficients of the magnetic moment expansion

according to

µ =
1

2

∑
q

Sqe
iqR + S∗

qe
−iqR

The Fourier coefficients of a given magnetic moment contain a phase factor determined

by symmetry and a refinable one. For the calculation of (hkl) − q satellites the complex

conjugate of Sj .

The calculated intensities, which are to be compared to the observed ones, are given by

IN (Q) = scale · y ·NN∗

and

IM (Q) = scale · y ·M⊥(Q)M⊥
∗(Q)

with the magnetic interaction vector

M⊥ = Q̂× (M(Q)× Q̂)

scale is a simple scaling factor and y is the extinction correction mentioned in Sec. 3.2.

7.2 Polarization matrices

The polarization values are calculated using the density matrix formalism [28] according

to

Pf =
Tr(σ · M · ρ · M†)

Tr(M · ρ · M†)

with

σ =

(
Pf,z Pf,x − iPf,y

Pf,x + iPf,y −Pf,z

)
,

ρ =
1

2

(
1 + Pi,z Pi,x − iPi,y

Pi,x + iPi,y 1− Pi,z

)
,

and

M =

(
N +M⊥,z −iM⊥,y

iM⊥,y N −M⊥,z

)
.

M† denotes the conjugate transpose of M. The coordinates x, y and z refer to the local

coordination system, where x is always parallel to the scattering vector Q, z is vertical

and y completes the right-handed coordination system. The initial neutron polarization

is considered by multiplying it to the matrix of the incident beam ρ. The finite 3He cell
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efficiency is considered in the same way in the matrix of the analyzed beam σ.

The final neutron spin Pf is related to the initial one by

Pi,f = PPi +P′

where P is a rotation matrix acting on the initial neutron spin Pi and P′ is the cre-

ated/annihilated polarization. By aligning the initial neutron polarization along the di-

rections x, y or z and by analyzing the component of the final neutron spin along these

directions, one can summarize nine measurements in the so-called polarization matrix,

which is better defined as a pseudomatrix, since it combines the rotation and the cre-

ated/annihilated polarization. For the general case, i.e. including nuclear, magnetic and

interference terms as well as different degrees of polarization and analyzer efficiency for

the different directions, the polarization matrix is

Pf,i =



pfx
pix(N

2−M2)−Jyz
Ix

pfx
−piyJnz−Jyz

Iy
pfx

pizJny−Jyz
Iz

pfy
pixJnz+Rny

Ix
pfy

piy(N
2+M2

⊥y−M2
⊥z)+Rny

Iy
pfy

pizRyz+Rny

Iz

pfz
−pixJny+Rnz

Ix
pfz

piyRyz+Rnz

Iy
pfz

piz(N
2−M2

⊥y+M2
⊥z)+Rnz

Iz


with N2 = NN∗, M2 = M⊥M

∗
⊥, M

2
⊥,y = M⊥yM

∗
⊥y and M2

⊥z = M⊥zM
∗
⊥z. The mixed

magnetic terms are Ryz = 2ℜ(M⊥yM
∗
⊥z) and Jyz = 2ℑ(M⊥yM

∗
⊥z), while the nuclear-

magnetic interference terms are Rny = 2ℜ(NM∗
⊥y), Rnz = 2ℜ(NM∗

⊥z), Jny = 2ℑ(NM∗
⊥y)

and Jnz = 2ℑ(NM∗
⊥z). The respective matrix elements are normalized to the scattered

intensity depending on the initial neutron polarization:

Ix = N2 +M2
⊥y +M2

⊥z + pixJyz

Iy = N2 +M2
⊥y +M2

⊥z + piyRny

Iz = N2 +M2
⊥yM

2
⊥z + pizRnz

In the absence of nuclear scattering, i.e. for a purely magnetic peak, N = Rny = Rnz =

Jny = Jnz = 0. One can in general assume the same degree of incident neutron polarization

as well as analyzer efficiency for the different directions: pix = piy = piz = p0 and

pfx = pfy = pfz = pf . The latter is equal to 1 for data which have been already corrected

for the analyzer efficiency. The above polarization matrix is obtained by applying the

density matrix formalism for each individual element.
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7.3 Flipping ratios

The flipping ratio R of a Bragg reflection is defined as the intensity ratio between spin-up

and spin-down neutrons and is given by

R =
I+

I−
=
NN∗ + (NP0M

∗
⊥ +N∗P0M⊥) +M⊥M

∗
⊥

NN∗ − (NP0M∗
⊥ +N∗P0M⊥) +M⊥M

∗
⊥

where P0 is the vector of the initial neutron polarization to be taken along the vertical

axis of the diffractometer and the dot product P0M⊥ gives the projection of the magnetic

interaction vector onto the vertical polarization axis.

The extinction correction for flipping ratios corresponds to the one which is applied in

FullProf [14], see the Flipping Ratios in FullProf manual.The flipping ratio is then

written as

R =
(NN∗ +M⊥,zM

∗
⊥,z)p

+
p + (N∗p+

mM⊥ +Np+
mM∗

⊥) + (1− q2)M⊥M
∗
⊥ypm

(NN∗ +M⊥,zM
∗
⊥,z)p

−
p + (N∗p−

mM⊥ +Np−
mM∗

⊥) + (1− q2)M⊥M
∗
⊥ypm

with the correction factors

p±p =
1

2

[
(1± P0)(1 +

0.001I+λ3xaniso

4 sin2(θ/λ) sin(2θ)
)−1/2 + (1∓ P0)(1 +

0.001I−λ3xaniso

4 sin2(θ/λ) sin(2θ)
)−1/2

]

p±
m =

1

2

[
(1± P0)(1 +

0.001I+λ3xaniso

4 sin2(θ/λ) sin(2θ)
)−1/2 − (1∓ P0)(1 +

0.001I−λ3xaniso

4 sin2(θ/λ) sin(2θ)
)−1/2

]
P̂0

ypm = (1 +
0.001xaniso(1− q2)M⊥M

∗
⊥λ

3r

4 sin2(θ/λ) sin(2θ)
)−1/2,

where P0 is the beam polarization and I± are the uncorrected intensities for a spin-up and

spin-down beam, respectively. q = sinα with α being the angle between the scattering

vector and the vertical axis.

Mag2Pol version 3.0 introduced the feature of calculating magnetization density maps.

For the observed maps and difference maps, the magnetic structure factors (the coefficients

of the Fourier inversion) are obtained by isolating M from the flipping ratio expression:

M2 + aM + b = 0

with

a =
2Nq2(Rp−m − p+m)

q4(Rp−p − p+p ) + (1− q2)q2ypm(R− 1)
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and

b =
N2(Rp−p − p+p )

q4(Rp−p − p+p ) + (1− q2)q2ypm(R− 1)

Note that the present version of Mag2Pol uses the calculatedM to derive the extinction

correction factors analytically although this is an approximation. A numeric method will

be implemented in a future release.

7.4 Multipoles

The magnetization density m(r) is described by

m(r) = R′
0C

′
0
0d′0

0(r̂) +
4∑

l=0

Rl(r)
l∑

m=−l

Cm
l d

m
l (r̂)

where the dml are the density-normalized real spherical harmonics yml whose normalization

constants can be found in [29]. The primed quantities denote the first monopole besides

the one specified by R0, C
0
0 and d00. Rl is the radial dependence of a Slater-type orbital:

Rl(r) =
Znl+3

(nl + 2)!
rnl exp(−Zlr)

where n and Z can be chosen to be different for each l value. Z and the coefficients Cm
l

are refinable parameters. The normalization is such that:

∞∫
r=0

Rlr
2dr = 1.

The real spherical harmonics yml are obtained from the spherical harmonics Y m
l according

to

yml =


√
2 Im(Y

|m|
l ), if m < 0

Y 0
l , if m = 0

√
2Re(Y

|m|
l ), if m > 0

The spherical harmonics parametrized in the angles θ and φ are given by

Y m
l (θ, φ) =

√
2l + 1

4π
· (l −m)!

(l +m)!
Pm
l (cos θ)eimφ

As indicated e.g. in [30] the Condon-Shortley phase (−1)m which can be seen in some

textbooks is included in the associated Legendre polynomials Pm
l so that, e.g. P 1

1 (x) =
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−(1 − x2)
1
2 and P−1

1 (x) = −1
2P

1
1 (x). Therefore, the density-normalized real spherical

harmonics are normalized so that:

π∫
θ=0

2π∫
φ=0

|dml (θ, φ)| sin(θ)dφdθ =

1, for l = 0

2, for l > 0

The magnetic form factor is given by the Fourier transform of the magnetization density

and results in

f(Q) = ⟨j′l(Q)⟩C ′
0
0d′0

0(Q̂) +
4∑

l=0

il⟨jl(Q)⟩
l∑

m=−l

Cm
l d

m
l (Q̂)

where Q̂ is parametrized in terms of θ and φ and ⟨jl(Q)⟩ being the Fourier-Bessel transform
of the radial density:

⟨jl(Q)⟩ =
∞∫

r=0

Rl(r)jl(Qr)4πr
2dr

jl(x) are the spherical Bessel functions:

j0(x) =
sinx

x

j1(x) =
sinx

x2
− cosx

x

j2(x) =
3

x2 − 1

sinx

x
− 3 cosx

x2

etc. Note that in the spherical Bessel functions Q is expressed in atomic units by multi-

plying the Bohr atomic radius a0 in Å and that f(Q=0)=1 for C0
0 = 1, since ⟨j0(0)⟩ = 4π

and d00(Q̂) = 1
4π .

7.5 Orbitals

Here, the magnetization density m(r) is given by

m(r) = |ϕl(r)|2 =

∣∣∣∣∣Rl(r)

l∑
m=−l

Cm
l d

m
l (r̂)

∣∣∣∣∣
2

= R2
l (r)

2l∑
l′=0,2...

l′∑
m=−l′

βml′ d
m
l′ (r̂)

The product of two spherical harmonics is expressed as a sum over spherical harmonics

according to the contraction rule and the relation between the coefficients Cm
l and βml are

obtained by equating the orbital expansion with the multipole expansion which results in

the so called M matrix (see [17]). Therefore, the magnetic form factor becomes

f(Q) =
2l∑

l′=0,2...

il
′⟨jl′(Q)⟩

l′∑
m=−l′

βml′ d
m
l′ (Q̂)
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7.6 Spin correlations

with ⟨jl′(Q)⟩ expressed like in the previous section

⟨jl′(Q)⟩ =
∞∫

r=0

R2
l′(r)jl′(Qr)4πr

2dr

The radial part can be expressed by using the tabulated ⟨jl′(Q)⟩ as for the sum of radial

integrals or by using Slater-like orbitals like in the multipole approach. A third option is

the hydrogen-like radial function which writes as

Rn,l =

[
ξ

2n
(n− l − 1)!(n+ l)!

] 1
2

exp

(
−ξr

2

)
(ξr)l+1

n−l−1∑
ν=0

(−ξr)ν

ν!(ν + 2l + 1)!(n− l − 1− ν)!

with ξ = 2Z
na0

.

7.6 Spin correlations

Given a periodic magnetic structure or the result of a reverse Monte-Carlo simulation in

a large supercell the intensities I(Q) can be calculated according to

I(Q) = C[µf(Q)]2 · 1

N

∑
i,j

[
Aij

sinQrij
Qrij

+Bij

(
sinQrij
(Qrij)2

− cosQrij
(Qrij)2

)]
, (7.1)

where C =
(γnre

2

)2
= 0.07265 barn, µ is the effective magnetic moment, f(Q) is the mag-

netic form factor, N is the number of atoms in the super cell, Q is the scattering vector

and the sum runs over the pairs of spins i and j separated by the distance rij . In order to

calculate the powder-averaged magnetic neutron scattering intensity for each spin pair in

the sum a local coordination system is defined where z is along the vector rij , y is parallel

to Si × z and x completes the right-handed system. With this definition Aij = Sx
i S

x
j and

Bij = 2Sz
i S

z
j − Sx

i S
x
j as implemented in Spinvert [27].

The analytical form of the mPDF was derived for the first time in [31] by calculating

the Fourier transform of the neutron scattering cross section from a collection of magnetic

moments. We have adapted the original formula by adjusting the prefactors in order to

be consistent with Eq. 7.1:

I(r) =
C[µf(Q)]2

b2M
· 1

N

∑
i,j

[
Aij

r
δ(r − rij) +Bij

r

r3ij
[1−Θ(r − rij)]

]
. (7.2)

b2M is the square of the magnetic scattering length 3.055 barn/str/Gd and 0.635 barn/str/Nd,

respectively. Furthermore, in order to allow the comparison with the Fourier transform of

the corrected raw data (without dividing by the magnetic form factor) we have replaced
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the delta function δ(r) and the step function Θ(r) by Gaussian and Error functions,

respectively, with a full width at half maximum (FWHM) in real space corresponding

to a Gaussian fit to the squared magnetic form factor in reciprocal space [FWHMR ≈
4 · ln(4)/(4πFWHMf2(Q))] (note that the factor 4π is due to the crystallographers’ def-

inition of Q widely used in particular for the analytical approximation of magnetic form

factors, which is also adapted in Mag2Pol).

7.7 Powder patterns

Rietveld refinement is a method which compares an experimentally observed powder (x-ray

or neutron) diffraction pattern with a calculated line profile in a least-squares algorithm un-

til the best possible agreement is found. Mag2Pol supports diffraction patterns recorded

on constant-wavelength and time-of-flight instruments and the data should contain the

scattering variable 2θ or TOF, the intensity and eventually the standard deviation of the

intensity. If the latter is not given (depending on the input file format), the program takes

the square root of the intensity.

The following features and equations are based on the FullProf manual. For the sake

of completeness of this manual, the implemented equations are listed here as well.

7.7.1 Calculated profile

The theoretical profile is calculated from the given structure model with nuclear and/or

magnetic contribution. A single point in this profile is calculated according to

ycal,i =
∑
P

SP
∑
Q

IP,Q · Λ(2θi − 2θP,Q −∆2θ) + bi

where the sum runs over the number of phases P and all Bragg reflections Q which

contribute to the point ycal,i. SP is the scale factor of phase P , Λ is the profile function

with its peak at 2θP,Q (∆2θ contains all systematic offsets, see Secs. 7.7.1.5 and 7.7.1.6)

and bi is the background which is calculated according to the model used (see Sec. 7.7.1.7).

The intensity of the Bragg reflection Q of phase P writes as

IP,Q = (m · L ·A · P · T · F 2)P,Q

F 2 is the square of the nuclear/magnetic structure factor corresponding toNN∗ orM⊥M
∗
⊥

as shown in Sec. 7.1 and m is the multiplicity of the peak [e.g. m = 4 for a (200) reflection

in tetragonal symmetry]. The remaining quantities are described in the following sections.
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7.7.1.1 Lorentz and polarisation factor

The Lorentz and polarisation factor L (in Debye-Scherrer geometry) is given by

L =
1−K +K cos2(2θM ) cos2(2θ)

2 sin2(θ) cos(θ)

with θM being the monochromator take-off angle and K the polarization factor, which is

0 for neutrons, 0.5 for characteristic non-polarised x-ray radiation and around 0.1 for syn-

chrotron radiation. Therefore, the take-off angle does not need to be given in the neutron

case.

7.7.1.2 Asymmetry

A is the peak asymmetry, a function which is multiplied to the profile function

A(x) = 1− A1Fa(x)−A2Fb(x)

tanh(θ)
− A3Fa(x) +A4Fb(x)

tanh(2θ)

with

x =
2θi − 2θQ −∆2θ

FWHM
∆2θ combines all systematic line-shifts which are explained in more detail in Sec. 7.7.1.6.

The functions Fa,b(x) are given by

Fa(x) = 2z exp(−z2)

Fb(x) = (2z2 − 3)Fa(x)

The parameters A1 to A4 can be refined. Note that the subtle differences in the equations

in comparison to the FullProf manual are on purpose, they have been adapted to obtain

the same asymmetries.

7.7.1.3 Preferred orientation

The two following preferred orientation functions are implemented in Mag2Pol:

• Exponential function

The correction factor for the calculated intensities is given by

PQ = P2 + (1− P2) exp(−P1α
2
Q)

αQ is the acute angle between the scattering vector Q and the normal of the preferred

orientation (hkl) vector which has to be defined by the user. P1 and P2 are refinable

parameters.
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• Modified March’s function

Here the correction is calculated by

PQ = P2 + (1− P2)

{
[P1 cos(αQ)]

2 +
sin2(αQ)

P1

}− 3
2

and P1 and P2 are again refinable parameters. P1 = 1 means no preferred orientation,

P1 < 1 refers to a platy habit (αQ is the acute angle between the scattering vector

and the normal of the crystallites) and P1 > 1 to a needle-like habit (αQ is the acute

angle bewteen the scattering vector and the axis of the needle).

7.7.1.4 Absorption and extinction

The effects of sample absorption depend on the scattering angle and can be corrected by

the following transmission factor for constant wavelength and Debye-Scherrer geometry:

TQ = exp
{
−
[
1.7133− 0.0368 sin2(θQ)

]
µλR+

[
0.0927 + 0.375 sin2(θQ)

]
[µλR]

2
}

The linear absorption coefficient is automatically calculated based on the given structure

model (averaged over the volumes of the contributing phases) and the corresponding wave-

length (λ1 or λ2), but the radius R of the cylindrical sample has to be given by the user.

For time-of-flight data different refinable absorption models are implemented:

• Model 1

Here the parameters µ1 and µ2 can be refined to mimic an effective µλR according

to

µλR = µ1 · λQ + µ2

with λQ being the wavelength associated with the particular reflection Q and the

transmission factor is given by

TQ =

1− µλR(1− 2
3µλR), if µλR ≤ 0.001

1−exp(−2µλR)
2µλR

, if µλR > 0.001

• Model 2

This model corresponds to the one for the constant-wavelength case, but with a

refinable parameter µ1 which is multiplied with λQ representing µλR:

TQ = exp
{
−
[
1.7133− 0.0368 sin2(θB)

]
µ1λQ +

[
0.0927 + 0.375 sin2(θB)

]
[µ1λQ]

2
}

Hereby, θB is half the scattering angle of the corresponding detector bank.
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• Model 3

Again, the parameter µ1 is multiplied with λQ associated to the reflection Q, there-

fore describing an effective µR, and the transmission factor is

TQ = exp(−µ1λQ)

• Model 4

This is the Loganov & alte da Veiga model [32]. For µ1λQ = µR < 3 cm−1

T = exp
[
−k0µ1λQ − k1(µ1λQ)

2 − k2(µ1λQ)
3 − k3(µ1λQ)

4
]

with

k0 =1.697653

k1 =
[
25.99978− 0.01911

√
sin(θB)

]
exp(−0.024514 sin2(θB))

+ 0.109561 sin(θB)− 26.0456

k2 =− 0.02489− 0.39499 sin2(θB) + 1.219077 sin3(θB)− 1.31268 sin4 θB

+ 0.871081 sin5(θB)− 0.2327 sin6(θB)

k3 = 0.003045 + 0.018167 sin2(θB)− 0.03305 sin4(θB)

For µ1λQ = µR > 3 cm−1 the transmission factor is given by

T =
k4 − k7

[1 + k5(µ1λQ − 3)]k6
+ k7

with

k4 = 1.433902 + 11.07504 sin2(θB)− 8.77629 sin4(θB)

+ 10.02088 sin6(θB)− 3.36778 sin8(θB)

k5 =
[
0.013869− 0.01249 sin2(θB)

]
exp

[
3.27094 sin2(θB)

]
+

0.337894 + 13.77317 sin2(θB)[
1 + 11.53544 sin2(θB)

]1.555039
k6 =

1.933433[
1 + 23.12967 sin2(θB)

]1.686715 − 0.13576 sin(θB) + 1.163198

k7 = 0.044365− 0.04259[
1 + 0.41051 sin2(θB)

]148.4202
For time-of-flight data a primary extinction correction is implemented which is cal-

culated according to [33]. The extinction correction E is a combination of Bragg

and Laue components

E = EB sin2(θB) + EL cos2(θB),
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where

EB =
1√
1 + x

and

EL = 1− x

2
+
x2

4
− 5x3

48
+ ... for x < 1

or

EL =

√
2

πx

(
1− 1

8x
− 3

128x2
− 15

1024x3
− ...

)
for x > 1

where

x = rbl

(
λQF

V

)2

where F is the calculated structure factor and V is the unit cell volume. rbl is a

refinable parameter and is a measure of the mosaic block size in µm2. Note that

a direct comparison of this value with FullProf is only possible, if the *.pcr file

contains the occupation factor as the ratio between special site and general site

multiplicity.

7.7.1.5 Profile functions

Except for the numerical and the split Pseudo-Voigt profile all constant-wavelength profile

functions available in FullProf are implemented inMag2Pol, in the current version two

time-of-flight peak profiles are implemented. If not otherwise specified, for all constant-

wavelength profiles the full width at half maximum Γ is composed of the Cagliotti formula

(u, v, w refinable parameters) and isotropic Gaussian broadening (IG refinable parameter):

Γ2 = u · tan2(θ) + v · tan(θ) + w +
IG

cos2(θ)

• Gaussian

Λ(x) = G(x) =
2

Γ

√
ln 2

π
exp

(
−4 ln 2

Γ2
x2
)

• Lorentzian

Λ(x) = L(x) =
aL

1 + bLx2

aL =
2

πΓ
bL =

4

Γ2

• Modified Lorentzian

Λ(x) =
aML

(1 + bMLx2)
2
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aML =
4
√√

2− 1

πΓ
bML =

4(
√
2− 1)

Γ2

• Intermediate Lorentzian

Λ(x) =
aIL

(1 + bILx2)
3/2

aIL =

√
22/3 − 1

Γ
bIL =

4(22/3 − 1)

Γ2

• Pearson VII

Λ(x) =
aV II

(1 + bV IIx2)
m

aV II =
Γ(m)

Γ(m)− 1/2

2
√
21/m − 1√
πΓ

bV II =
4(21/m − 1)

Γ2

The refinable parameter m can optionally be set to be a function of the scattering

angle (in degrees):

m = m0 +
100 ·X

2θ
+

1000 · Y
(2θ)2

where X and Y are further refinable parameters.

• Pseudo-Voigt

Λ(x) = pV (x) = η · L(x) + (1− η) ·G(x) 0 ≤ η ≤ 1

where L(x) and G(x) have the same full width at half maximum Γ. The mixing

parameter η can optionally be set to be a function of the scattering angle (in degrees):

η = η0 +X · 2θ

• Tripled Pseudo-Voigt

Λ(x) = X · pV (x−D) + (1−X − Y ) · pV (x) + Y · pV (x+D)

D =
S

d cos(θ)

where d is the d-spacing of the (hkl) reflection for which the profile is calculated and

S is a refinable parameter. The three Pseudo-Voigt profiles have the same η0 and Γ

and are mixed according to the refinable parameters X and Y .
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• Pseudo-Voigt with Finger-Cox-Jephcoat asymmetry [34]

Λ(x) =

Nmax∑
n=1

wnW (δn,2θ)pV (x+2θ−δn)
h(δn) cos(δn)

Nmax∑
n=1

wnW (δn,2θ)
h(δn) cos(δn)

The sum is a numerical integration corresponding to a Gauss-Legendre quadrature

procedure with wn and xn being the Gauss-Legendre weights and abscissae associ-

ated with the nth point and Nmax is the number of points chosen. In the original

paper it is recommended that Nmax ≥ 30 for values within six half-widths of the

profile peak and Nmax = 10 outside this region. Mag2Pol uses Nmax = 30 for every

point which yields smooth peak profiles with sufficiently fast calculation times.

h(δ) =

√
cos2(δ)

cos2(θ)
− 1 δn =

1

2
(2θ + 2φmin) +

xn
2
(2θ − 2φmin)

W (2φ, 2θ) =


SL +DL − h(δn), for 2φmin ≤ 2φ < 2φinfl

2min(SL, DL), for 2φinfl ≤ 2φ ≤ 2θ

0, else

The inequalities above apply to 2θ < 90◦ and have to be inverted for 2θ > 90◦.

Bragg peaks with a scattering angle closer than 0.1◦ to 90◦ are not corrected in

Mag2Pol. The respective limiting 2φ angles are given by

2φmin = cos−1
[
cos(2θ)

√
(SL +DL)2 + 1

]
2φinfl = cos−1

[
cos(2θ)

√
(DL − SL)2 + 1

]
The parameters SL and DL are refinable. The first refers to half the sample height

divided by the sample-to-detector distance and the second is half the detector height

divided by the sample-to-detector distance. The implemented code was successfully

compared to the example given in the original paper as well as with FullProf

examples. The recast of variables for special values of SL and DL in the refinement

procedure as proposed in [35] is implemented but needs to be tested more throroughly

as the resulting standard deviation proved to be a bit high for some examples.

• Thompson-Cox-Hastings Pseudo-Voigt with Finger-Cox-Jephcoat asymmetry

In comparison to the Pseudo-Voigt profile above the parameter η is not refinable but

calculated from the Lorentzian and Gaussian linewidths:

ΓG =

√
u · tan2(θ) + v · tan(θ) + w +

IG
cos2(θ)
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ΓL = X · tan(θ) + Y

cos(θ)

with X and Y being refinable parameters The numerical Pseudo-Voigt approxima-

tion of the convolution between the Lorentzian and a Gaussian function yields

Γ =
(
Γ5
G + 2.69269 · Γ4

GΓL + 2.42843 · Γ3
GΓ

2
L + 4.47163 · Γ2

GΓ
3
L + 0.07842 · ΓGΓ

4
L + Γ5

L

)1/5
η = 1.36603 · ΓL

Γ
− 0.47719 ·

(
ΓL

Γ

)2

+ 0.11116 ·
(
ΓL

Γ

)3

These values Γ and η are then used in the Pseudo-Voigt function pV (x) and the

optional Finger-Cox-Jephcoat asymmetry is calculated as described in the previous

point.

• Convolution of Pseudo-Voigt with a pair of back-to-back exponentials

Λ(x) = pV (x)⊛ E(x) =

∞∫
−∞

pV (x− t)E(t)dt

= (1− η)N [eu erfc(y)ev erfc(z)]− 2Nη

π
{ℑ[epE1(p)] + ℑ[eqE1(q)]}

with erfc being the complementary error function, E1 the exponential integral and

N =
αβ

2(α+ β)
.

The exponents u and v are given by

u =
1

2
α(ασ2G + 2x) u =

1

2
β(βσ2G − 2x),

the arguments y, z by

y =
ασ2G + x√

2σ2G

z =
βσ2G − x√

2σ2G

and the arguments p and q by

p = αx+
iαΓ

2
p = −βx+

iβΓ

2
.

The Gaussian component of the Pseudo-Voigt function is expressed by

σ2G = σ0 + σ1 · d2 + (σ2 + IG) · d4 =
Γ2
G

8 ln 2

and the Lorentzian component writes as

γL = γ0 + γ1 · d+ γ2 · d2 = ΓL.
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Note that the Lorentzian size broadening is not yet implemented in Mag2Pol. The

relations between ΓG, ΓL and Γ as well as η are the same as for the Thompson-Cox-

Hastings Pseudo-Voigt function. The rise and decay constants α and β are given

by

α = α0 +
α1

dQ
β = β0 +

β1
d4Q

• Convolution of Pseudo-Voigt with the Ikeda-Carpenter function

The Ikeda-Carpenter function is the result of the convolution of two functions

Sk(t) =
α3

2
t2e−αt Rk(t) = (1−R)δ(t) +Rβe−βt,

which describe leakage of fast and slow neutrons from the moderator with the fast

and slow decay constants α and β:

Ik(t) = Sk(t)⊛Rk(t) = (1−R)Sk(t)⊛ δ(t) +RβSk(t)⊛ e−βt

= (1−R)Sk(t) +Rβ

∞∫
−∞

Sk(τ)
[
e−β(t−τ)

]
dτ

= (1−R)Sk(t) +Rβe−βt

t∫
0

Sk(τ)e
βtdτ

=
α3

2

{
(1−R)t2e−αt +

2Rβ

(α− β)3

[
e−βt − e−αt

(
(α− β)2

t2

2
+ (α− β)t+ 1

)]}
The implemented peak profile is obtained by the convolution of a Pseudo-Voigt

function with the Ikeda-Carpenter function:

Λ(x) = pV (x)⊛ Ik(x) =

∞∫
−∞

pV (x− t)Ik(t)dt = N [(1− η)ΛG(x) + ηΛL(x)]

with

N =
α(1− k2)

4k2

The Gaussian part ΛG is given by

ΛG(x) = Nue
u erfc(yu) +Nve

v erfc(yv) +Nse
s erfc(ys) +Nre

r erfc(yr)

with

Nu = (1−R
α−

w
) Nv = (1−R

α+

z
) Ns = −2(1−R

α

y
) Nr = 2Rα2β

k2

wyz

and

yu =
α−σ2G − x√

2σ2G

yv =
α+σ2G − x√

2σ2G

ys =
ασ2G − x√

2σ2G

yr =
βσ2G − x√

2σ2G
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where k = 0.05, R = exp
(
−81.799

κλ2

)
, α− = α(1 − k), α+ = α(1 + k), w = α− − β,

y = α− β and z = α+ − β. The parameters α and β are

α =
1

α0 + λα1
β =

1

β0

The u, v, s and r arguments of the exponential functions are

u =
1

2
α−(α−σ2G−2x) v =

1

2
α+(α+σ2G−2x) s =

1

2
α(ασ2G−2x) r =

1

2
β(βσ2G−2x)

The Lorentzian part is described by

ΛL(x) = − 2

π
{Nuℑ [ezuE1(zu)] +Nvℑ [ezvE1(zv)] +Nsℑ [ezsE1(zs)] +Nrℑ [ezrE1(zr)]}

with the zn being

zs = −αx+1

2
iαγL zu = −α−x+

1

2
iα−γL zv = −α+x+

1

2
iα+γL zr = −βx+1

2
iβγL

Note that σG and γL have the same definition as for the previous peak profile (con-

volution of Pseudo-Voigt and back-to-back exponentials).

7.7.1.6 Offsets / Time of flight

Systematic line-shifts in a powder pattern can occur due to an improper alignment of the

sample and/or the detector. The first offset parameter, ∆0 simply adds to the calculated

2θ value of a Bragg reflection and corresponds to the zero-shift of the detector. The

sample-dependent line-shifts result from the eccentricity e of a sample with radius R from

the central position

• perpendicular to the incident beam direction

∆2θ =
e

R
cos(2θ) = ∆x cos(2θ)

• parallel to the incident beam direction

∆2θ =
e

R
sin(2θ) = ∆y sin(2θ)

The above equations apply to the Debye-Scherrer geometry and the parameters ∆x and

∆y are refinable. Note that the correction perpendicular to the incident beam direction

is different from the cos(θ) term in the FullProf manual, but both programs yield no

shift for 2θ = 90◦.

For TOF data the instrumental offsets in the peak positions are given by the 3 parameters

Z0, D1 and D2 which yield the time of flight TQ for a reflection Q with d-spacing dQ:

TQ = Z0 +D1 · dQ +D2 · d2Q
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7.7.1.7 Background

The different possibilities to describe the background of a powder diffraction pattern in

Mag2Pol are explained below

• linear interpolation

The user defines a number of discrete background points as explained in Sec. 4.5.3

and the program calculates a linear interpolation. The slope beyond the first and

last point is simply continued. When 0 points are defined, the background is 0

everywhere; when 1 point is defined, the background is flat and goes through that

point.

• polynomial (6 coefficients)

bi =

5∑
m=0

Cm

(
2θi
B0

− 1

)m

where the coefficients C0 to C5 are refinable parameters and B0 is the adaptable

origin of the polynomial.

• polynomial (12 coefficients)

bi =
−1∑

m=−3

Cm (2θi)
m +

8∑
m=0

Cm

(
2θi
B0

− 1

)m

where the coefficients C−3 to C8 are refinable parameters and B0 is the adaptable

origin of the polynomial.

• polynomial (6 coefficients) + Debye-like

bi =

5∑
m=0

Cm

(
2θi
B0

− 1

)m

+

6∑
n=1

C ′
n

sin(Qirn)

Qirn

with Qi = 4π sin(θi)
λ . The coefficients C0 to C5 as well as C ′

1 to C ′
6 and r1 to r6 are

refinable parameters and B0 is the adaptable origin of the polynomial.

7.8 Standard deviations and agreement factors

The standard deviations σ are obtained by taking the square root of the diagonal of the

covariance matrix C:

C = α−1 · χ2
r
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The correlation matrix is obtained by dividing the elements Ci,j by the standard deviations

σi · σj . α is a n× n square matrix with n the number of refined parameters xj :

α = DT ·D

with D being a m× n matrix (m is the number of observations yobs,i or calculated values

ycal,i) where the jth column is given by:

D(j) =
ycal,i(xj +∆)− ycal,i(xj −∆)

2∆σi

The reduced χ2
r value is defined as

χ2
r =

χ2

(m− n)
.

and χ2 is expressed by

χ2 =
∑
i

(
yobs,i − ycal,i

σi

)2

.

The observed and calculated values, yobs,i and ycal,i, can be integrated intensities, polar-

ization matrix elements or a point in a diffraction pattern.

The crystallographic RF factor is given by

RF = 100 ·

∑
Q

|Fobs,Q − Fcal,Q|∑
Q

Fobs,Q

and is calculated when integrated intensities or powder patterns are refined. In the case

of powder data refinement the observed quantities Fobs,i are calculated from the Rietveld

formula:

Iobs,Q = Ical,Q ·

∑
i
wi ·

yobs,i−bi
ycal,i−bi∑

i
wi

with

wi = Λ(2θi − 2θQ −∆2θ) ·A

i.e. the observed intensities are extracted based on the underlying structure model and

peak clusters are proportionally decomposed depending on the calculated intensities which

contribute. The weighting factors correspond to the amplitude within a specific profile

function multiplied by the asymmetry function (note that the asymmetry is not included

in FullProf, which, however does not make a difference).

For the determination of the standard deviations of the observed intensities the error

propagation of the quantity (yobs,i − bi)/(ycal,i − bi) is derived which results in

σ(Iobs,Q) =
Ical,Q√∑

i
wi
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with

1/wi = σ2(yobs,i) ·
{

1

(ycal,i − bi)2
+

[
yobs,i − bi

(ycal,i − bi)2
ycal,i
yobs,i

]2
+

[
yobs,i − ycal,i
(ycal,i − bi)2

bi
yobs,i

]2}
The observed structure factor is then obtained from the observed intensity corrected for

the peak multiplicity and the Lorentz factor:

Fobs,Q =

√
Iobs,Q
m · L

.
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